
 

ZoomInfo Release Notes 
These release notes describe new features and 
improvements for ZoomInfo releases 

 

Current Release 
 

May 19, 2026 
 
 
Our user experience continuously evolves. Over time, 
descriptions of new features and enhancements in these 
release notes may no longer accurately reflect the current 
user experience. Visit the ZoomInfo Knowledge Center for 
public content that supports the current functionality.    

 
 
 
 

Previous Releases 
 

Apr 21, 2026 

Mar 17, 2026 
Feb 17, 2026 

Jan 21, 2026 

Dec 9, 2025 
Nov 18, 2025 

Oct 21, 2025 

Sept 16, 2025 
Aug 19, 2025 

Jul 15, 2025 
 
 

 

 

 

 
   Join our ZoomInfo Champions Program today!   
   Play a role in shaping the future of Go-to-Market. Provide first-hand​
   feedback on upcoming product innovations, join exclusive events, and more.   
   I want to join 

 

​
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May 19, 2026 ZoomInfo Release 
Data 

May 2026 Company Data Cube Release 

More Contacts Now Show Verified Local Office Addresses 

Contact & Leadership Coverage from Company Websites 

More Precise Contact-to-Company Matching Across the Database 

Broader Source Mix Behind ZoomInfo's Alternative Emails and Phone Numbers 

Applications 

GTM Studio 

Forms in GTM Studio Audiences 

Duplicate Audiences 

Edit Audience Import Criteria 

Chorus 

New Chorus Engagement Filters: Find the Right Calls Faster 

Find Any Call or Meeting in Chorus Using Plain-English Search 

Get Instant Answers from Any Recorded Meeting with Chorus AI Chat 

Ecosystem & Admin 

Update Your SSO Signing Certificate Without a Full Metadata Refresh 

Bulk User Management: Assign Roles Directly in the Bulk Upload CSV 

Integrations & Connectors 

MCP Connectors 

ZI API Integrations 

Data Enrichment Connectors 
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Data 
 
May 2026 Company Data Cube Release 
 
Three big changes ship in the May 2026 Company Data Cube: 

●​ Publishability alignment between Cube and Platform: 23.05M companies and 1.64M locations move 
out of the customer-visible cube so the same record returns the same answer on every ZoomInfo 
surface. The cleanup is dominated by Tier B; Tier A is essentially preserved. (The broader standalone 
location-level alignment of an additional 40.23M location rows is on the June 15 cube; see full release 
notes.) 

●​ Employee Growth Rate (EGR) v2 methodology lands directly in the cube: significantly higher fill rates 
and accuracy than the prior model. 

●​ Tier B industry classification refresh: 11M Tier B companies repredicted using the upgraded industry 
model that refreshed Tier A in April. Large change rates expected. 

M8 MVP is in production-readiness this cube; the first customer-visible Company 3.0 milestones follow in 
July. 
 
Links 

●​ Official Data Cube Release Note 
 

 
More Contacts Now Show Verified Local Office Addresses 
 
Field sales reps can now route to the right building, territory managers can assign contacts to the correct 
region, and ABM teams can run direct mail to the actual office because more contacts in ZoomInfo now carry 
a verified street address for the specific branch, plant, or facility where they work, not a corporate 
headquarters that may be located in a different city entirely. ZoomInfo cleaned and standardized company 
office location records across the database, resolving 11 million additional contacts from headquarters or 
city-only data to verified local office addresses. The improvement is live now for all customers across the 
platform, bulk exports, API enrichment, and CRM integrations with no configuration. 
 
Use Case Tags: Territory Design and Segmentation, Prospecting, Audience Development, Ad Campaign 
Execution & ABM, Data Management 
Primary Personas: Field Sales Reps, Sales Managers, ABM Managers, Demand Generation Managers 
 

 
 
Contact & Leadership Coverage from Company Websites 
 
Reach contacts at the small and mid-size businesses your team targets including regional distributors, local 
professional services firms, and international SMB accounts with 6 million new contacts now available across 
millions of companies, roughly half of them international. ZoomInfo has advanced its web crawling, detection, 
and extraction capabilities to reliably read company websites as a primary data source, capturing the contact 
and employment data companies publish about their own people and feeding it directly into search, audience 
building, enrichment, and Copilot workflows. Executive and board contacts reflect what each company 
currently publishes on its own leadership pages, so your team can act on them without cross-checking 
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accuracy before outreach. Available now to all customers across SalesOS, GTM Studio, Marketing, and Copilot 
at no additional cost, with no setup required. 
 
Use Case Tags: Data Management · Prospecting · Audience Development · Ad Campaign Execution & ABM · 
Account Insights · Total Addressable Market (TAM) 
Primary Personas: SDRs · Account Executives · Marketing Operations · Demand Generation Managers · 
Revenue Operations 
 

 

More Precise Contact-to-Company Matching Across the Database 
 
ZoomInfo has upgraded contact-to-company matching to use company name, domain, and social URL as 
combined signals, so the contacts you pull at any target account more accurately reflect who works there. 
The improvement has been validated at 93.3% precision across more than 1 million affected contact records 
and applies automatically across search, prospecting, audience building, and CRM enrichment workflows with 
no customer action required. Accuracy continues to improve as new records are processed through the 
updated matching pipeline. 

Use Case Tags: Data Management, Prospecting, Audience Development, Account Insights  
Primary Personas: SDRs & AEs, RevOps & Marketing Operations, Demand Generation 

 
 
Broader Source Mix Behind ZoomInfo's Alternative Emails and Phone Numbers 
 
ZoomInfo now sources alternative emails and phone numbers from a broader range of data providers, making 
the coverage that converts unreachable contacts into actionable ones less dependent on any single source 
and less vulnerable to gaps in specific industries or regions. The most significant improvement is in free email, 
where a more varied mix of providers now supplies 84% of the alternative emails ZoomInfo surfaces, up from 
65%. The change applies automatically with no customer action required, currently live in GTM Studio and 
DaaS with rollout to all ZoomInfo products in progress. 
 
Use Case Tags: Data Management, Prospecting, Audience Development 
Primary Personas: SDRs & AEs, Marketing Operations, Demand Generation, RevOps 
 

 
 

Applications 

 
GTM Studio 
 

Forms in GTM Studio Audiences 
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Connect more third-party data connectors to enrich GTM Studio Audiences, without needing every required 
parameter pre-populated as an Audience column. Forms let users pass the specific inputs a connector needs 
including vendor dropdowns, free-text fields, and flexible field mappings that combine Audience column 
values with static text in a single input. Admins can configure the full form experience through a no-code 
interface, with control over field names, display order, helper text, and dropdown options. Available in 
Audiences via Actions > View all enrichments. 
 
Use Case Tags: Data Enrichment, Audience Development, Account Prioritization, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Duplicate Audiences 
 
Create complete copies of audiences with all data, enrichments, and configurations preserved; perfect for 
testing variations without risking original work or creating personal copies of shared team audiences. 
Duplicate individual sheets within the same audience (maintaining parent-child relationships for Find 
Contacts results) or copy entire audiences to create a new audience. All processed AI enrichments, custom 
formulas, and ZoomInfo attributes are pre-populated in the duplicate without consuming additional credits or 
requiring re-runs. 
 
Use Case Tags: Collaboration, Workflow Efficiency, Data Management, Team Enablement 
Primary Personas: Revenue Operations, Sales Operations, Marketing Operations, Account Executives 
 

 
 
Edit Audience Import Criteria 
 
Refine audience targeting after creation by editing import criteria directly. No need to rebuild from scratch 
and lose enrichment work. Update filters to add forgotten criteria, adjust territory boundaries, or exclude test 
accounts while preserving all AI-generated columns, custom formulas, saved views, and automated refresh 
settings. Records that still match the updated criteria keep all their processed data intact, while new records 
that match require a "run" to populate enrichment columns. 
 
Use Case Tags: Data Management, Audience Development, Workflow Efficiency, Territory Design 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
 

 
 

 

Chorus 
 

New Chorus Engagement Filters: Find the Right Calls Faster 
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The Chorus engagements page now includes three new filters to cut through noise and surface the calls most 
relevant to your workflow:  

●​ Rep Has Spoken shows only calls where a rep actively participated; eliminating meetings they were 
invited to but never attended. 

●​ Hide Internal Meetings removes standups, team syncs, and internal calls so you see only external 
customer-facing engagements. 

●​ Deck Shared narrows results to calls where a presentation was shown.  
 
All three filters work together and compose with your existing filter set. Available now in the Engagement Info 
section of the filter panel on the Chorus engagements page. 
 
Use Case Tags: Account Insights, Playbook Design, Prospecting 
Primary Personas: Sales Managers, Enablement, Account Executives 
 

 
 
Find Any Call or Meeting in Chorus Using Plain-English Search 
 
Search Chorus in plain English by typing queries like "meetings with Acme last month" or "Sarah's recent calls," 
and Chorus AI Search automatically translates your intent into precise filters and routes you directly to the 
results. Access AI Search from the global navigation bar and toggle into AI mode to get started. 
 
Use Case Tags: Account Insights, Deal Management, Playbook Design 
Primary Personas: Sales Managers, Account Executives / Account Managers 
 

 
 
Get Instant Answers from Any Recorded Meeting with Chorus AI Chat 
 
Chorus now includes an AI chat assistant directly inside every recorded meeting. Ask natural language 
questions like "What were the key takeaways?", "What did the economic buyer say about pricing?", "When did 
the competitor come up?" and get instant answers with clickable links that jump you directly to the exact 
moment in the recording. No more scrubbing through hour-long calls to find what you need. 
 
Use Case Tags: Account Insights, Prospecting, Deal Management, Playbook Design 
Primary Personas: Account Executives / Account Managers, Sales Development Representatives, Sales 
Managers 
 

 
 

Ecosystem & Admin 
 
Update Your SSO Signing Certificate Without a Full Metadata Refresh 
 
Administrators with an active SSO configuration can now update their signing certificate directly in the 
Admin Portal without requiring any changes in your Identity Provider. Certificate renewals previously required 
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uploading a complete XML metadata file, forcing a full IdP reconfiguration that meant coordination across two 
systems and introduced unnecessary risk of SSO disruption. Open the new "Update Signing Certificate" 
section in the Admin Portal > SSO Configuration, upload your updated certificate (.crt, .cert, .pem, .cer) via 
drag-and-drop or file browser, and all existing SAML Service Provider Details like your login URLs, Entity ID, 
and endpoints remain untouched. 
 
Use Case Tags: Administration & Setup — System Configuration & Technical Setup; System Governance & 
Compliance Management; User Provisioning & Access Management 
Primary Personas: IT Administrators; Security Administrators; Revenue Operations 
 

 
 
Bulk User Management: Assign Roles Directly in the Bulk Upload CSV 
 
Admins can now assign roles to new and existing users directly in the bulk upload CSV. The updated template 
includes an optional Role column that automatically maps each user to the correct role once the upload 
completes. Previously, every bulk upload required a second round of manual, per-user role assignments, 
leaving new team members without the right access until an admin returned to configure each account 
individually. Download the updated CSV template from the Admin Bulk Upload tool to get started. 
 
Use Case Tags: Administration & Setup — User Provisioning & Access Management; Tool Configuration & 
User Assignment 
Primary Personas: System Administrators; IT Managers; Revenue Operations 
 

 
 

Integrations & Connectors 
MCP Connectors  

Microsoft Copilot Studio & Dynamics 365  
 
ZoomInfo's MCP server connects to Microsoft Copilot Studio and Dynamics 365 via Custom MCP Connector, 
so teams can query ZoomInfo B2B contact and company data directly within their Copilot-powered agents 
and Dynamics environments. 
 
Connect via Custom MCP Connector in your Microsoft environment. Setup guide on the ZoomInfo 
Marketplace. 
 
Use Case Tags: Prospecting, Account Insights, Data Management  
Primary Personas: AEs, RevOps, Developers 
 

 
 
Dust  
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ZoomInfo is now available as a remote MCP data source on Dust.tt. Connect ZoomInfo within your Dust 
agents and workflows to pull live B2B contact and company data directly into your automations, so your 
agents are working with real prospect intelligence at every step. 
 
Connect via the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting, Account Insights, Data Management  
Primary Personas: SDRs, AEs, Developers 
 

 
 
Claude Code  
 
Connect ZoomInfo to Claude Code via MCP and query live B2B contact and company data directly from your 
coding session. Build and test ZoomInfo-powered features without leaving your development environment, 
no separate API setup required. 
 
Connect via MCP OAuth App. Setup guide on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Prospecting  
Primary Personas: Developers, RevOps 
 

 
 
Codex  
 
ZoomInfo is wired into Codex via MCP, giving your development environment direct access to live B2B 
contact and company data. Build, query, and test ZoomInfo-powered features without leaving your coding 
workflow or setting up a separate API. 
 
Connect via Settings > Custom MCP. Setup instructions on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Prospecting ​
Primary Personas: Developers, RevOps 
 

 
 
Google ADK  
 
ZoomInfo is now listed in the Google Agent Development Kit (ADK) marketplace at adk.dev/integrations. If 
you're building multi-agent systems with Google ADK, you can connect ZoomInfo as a native MCP data 
source and give your agents direct access to live B2B contact and company data. 
 
Connect via MCP OAuth App. Setup guide on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Prospecting  
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Primary Personas: Developers, RevOps 
 

 
 
Perplexity AI  
 
ZoomInfo is now available as a native data connector in Perplexity's "Computer" feature for all paid Perplexity 
subscribers. When you're researching a target company or building a prospect list in Perplexity, ZoomInfo B2B 
contact and company data surfaces directly in your results. 
 
Connect your ZoomInfo account via the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting, Account Insights ​
Primary Personas: SDRs, AEs, RevOps 
 

 
 
ChatGPT  
 
ZoomInfo's MCP connector is now listed in the ChatGPT app directory. If you have the ZoomInfo ReachOut 
Chrome Extension, you'll now see a prompt to connect when you're active on ChatGPT, making it easy to 
query ZoomInfo B2B contact and company data right within your conversations. 
 
Find the connector in the ChatGPT app directory or on the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting, Account Insights  
Primary Personas: SDRs, AEs 
 

 

ZI API Integrations 

Nooks  
 
ZoomInfo now integrates natively with Nooks, so your team has ZoomInfo-enriched contact and company 
data right inside the dialer the moment they pick up the phone. No more switching tabs to look up a prospect 
mid-call. 
 
Available on the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting  
Primary Personas: SDRs 
 

 
 
Cvent (iCapture)  
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Cvent's iCapture event lead capture product now has a native ZoomInfo connector. When your team 
captures leads at events, those records are automatically enriched with ZoomInfo contact and company data, 
giving sales teams complete records from day one rather than incomplete lead forms. 
 
 Available on the ZoomInfo Marketplace.  
 
Use Case Tags: Lead Management, Data Management  
Primary Personas: Marketing Ops, RevOps 
 

 
 
Athean  
 
ZoomInfo now integrates natively with Athean, so the accounts Athean flags as high-priority arrive already 
enriched with ZoomInfo B2B data. Your team has the full context they need to act on those signals the 
moment they surface. 
 
Available on the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting, Account Prioritization  
Primary Personas: SDRs, AEs 
 

 
 
Konnectify  
 
ZoomInfo now integrates natively with Konnectify. Whether you're syncing enrichment data to your CRM, 
routing leads, or building custom automations, you can pull ZoomInfo contact and company data into any 
Konnectify workflow without custom API work. 
 
Available on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management  
Primary Personas: RevOps, Marketing Ops 
 

 
 
DataGroomr  
 
ZoomInfo now integrates natively with DataGroomr, so your Salesforce records are automatically enriched 
and validated against ZoomInfo's B2B data. Keep your CRM accurate without manual cleanup. 
 
 Available on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management  
Primary Personas: RevOps, Sales Ops 
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Data Enrichment Connectors 

Firecrawl  
 
Enrich GTM Studio Audiences with live web intelligence scraped from company websites using Firecrawl as a 
no-code data connector. Whether you need to track what companies are actively publishing, identify 
technology mentions, or surface custom signals from any site, Firecrawl pulls that intelligence directly into 
your audience records alongside ZoomInfo's native B2B data. 
 
 Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Audience Development  
Primary Personas: RevOps, Marketing Ops 
 

 
 
RB2B  
 
RB2B is now available as a data enrichment connector in GTM Studio. If you use RB2B to identify the 
companies and individuals visiting your website, you can now bring those real-time visitor signals into your 
GTM Studio Audiences to turn anonymous traffic into actionable prospect records.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, Account Prioritization  
Primary Personas: RevOps, Marketing Ops, Demand Generation 
 

 
 
People Data Labs  
 
People Data Labs is now available as a data enrichment connector in GTM Studio. If you use PDL to access 
person and company profiles, you can now enrich your GTM Studio Audiences with employment history, 
social data, location, and education attributes.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace. 
 
Use Case Tags: Data Management, Audience Development  
Primary Personas: RevOps, Marketing Ops 
 

 
 
PCRecruiter  
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PCRecruiter is now available as a data enrichment connector in GTM Studio. If you use PCRecruiter to manage 
your staffing and executive search workflows, you can now enrich GTM Studio Audiences with your 
candidate, client, and placement data.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace. 
 
Use Case Tags: Data Management, Audience Development  
Primary Personas: RevOps, Sales Ops 
 

 
 
JETNET  
 
JETNET is now available as a data enrichment connector in GTM Studio. If you work in aviation, aerospace, or 
finance and use JETNET for aircraft fleet data and market intelligence, you can now enrich GTM Studio 
Audiences with those industry-specific signals to build more precise targeting.  
 
Now available in the enrichment options within GTM Studio.  
 
Use Case Tags: Audience Development, TAM  
Primary Personas: RevOps, Marketing Ops 
 

 
 
Candid  
 
Candid is now available as a data enrichment connector in GTM Studio. If you sell to foundations or nonprofits 
and use Candid to research grant funding and organizational data, you can now bring that intelligence into 
your GTM Studio Audiences to build more informed targeting.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, TAM  
Primary Personas: RevOps, Marketing Ops 
 

 
 
ProPublica  
 
ProPublica is now available as a data enrichment connector in GTM Studio. If you target nonprofits and use 
ProPublica's public IRS Form 990 data to research organizational financials, executive compensation, and 
filings, you can now bring that intelligence into your GTM Studio Audiences.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, Account Insights  
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Primary Personas: RevOps, Marketing Ops 
 

 
 
WealthEngine  
 
Pull WealthEngine's individual wealth intelligence directly into GTM Studio Audiences as a no-code data 
connector. For fundraising, financial services, and premium sales teams, net worth, income, and donation 
propensity signals from WealthEngine add individual-level wealth targeting to every audience you build. 
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, Account Prioritization  
Primary Personas: RevOps, Marketing Ops 
 

 
 
Leadfeeder  
 
Leadfeeder is now available as a data enrichment connector in GTM Studio. If you use Leadfeeder to identify 
companies visiting your website, you can now bring those intent signals into your GTM Studio Audiences to 
surface and prioritize the accounts already showing active interest.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, Account Prioritization  
Primary Personas: RevOps, Demand Generation 
 

 
 
Bytemine  
 
Bytemine is now available as a data enrichment connector in GTM Studio. If you use Bytemine to access 
verified contact data, you can now enrich GTM Studio Audiences with work emails, personal emails, mobile 
numbers, and direct dials from Bytemine's database of 100M+ contacts.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Prospecting  
Primary Personas: RevOps, SDRs 
 

 
 
Leadsforge  
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Bring Leadsforge's verified prospect data from multiple databases into GTM Studio Audiences as a no-code 
enrichment connector. Leadsforge draws from multiple contact databases to find and verify prospects, so 
those multi-source verified records pull directly into every row alongside your ZoomInfo data. 
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Prospecting  
Primary Personas: RevOps, SDRs 
 

 
 
GetProspect  
 
Add verified emails and phone numbers from GetProspect's B2B contact database to GTM Studio Audiences 
as a no-code data connector. GetProspect is built for sales teams, business developers, and marketers, and 
connecting it to GTM Studio means more ways to reach every contact in your audience directly from your 
enrichment workflow. 
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Prospecting, Data Management  
Primary Personas: SDRs, RevOps 
 

 
 
Trestle  
 
Layer Trestle's identity verification and contactability signals into GTM Studio Audiences as a no-code 
enrichment connector. Trestle's next-generation identity APIs confirm who your contacts are and how to 
reach them, pulling that verification intelligence directly into your audience records alongside ZoomInfo's B2B 
data. 
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Data Management, Audience Development  
Primary Personas: RevOps, Marketing Ops 
 

 
 
Exa  
 
Exa is now available as a data enrichment connector in GTM Studio. If you use Exa to search the web and 
extract structured company signals, related organizations, and relevant content, you can now bring that 
AI-powered web intelligence into your GTM Studio Audiences.  
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
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Use Case Tags: Audience Development, Account Insights  
Primary Personas: RevOps, Marketing Ops 
 

 
 
Allegrow  
 
Connect Allegrow to GTM Studio as a no-code enrichment connector and pull email deliverability scores and 
spam risk signals directly into your audience records. Allegrow combines AI-driven deliverability scoring with 
unlimited verifications and spam prevention, so every record in your audience includes deliverability context 
before it goes into an outreach campaign. 
 
Now available in the enrichment options within GTM Studio and on the ZoomInfo Marketplace.  
 
Use Case Tags: Audience Development, Data Management  
Primary Personas: RevOps, Marketing Ops, Demand Generation 
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April 21, 2026 ZoomInfo Release 
Data 

AI-Powered Title Classification 

25 Million Newly Published Contacts 

Location Enrichment Now Identifies the Right Location More Accurately 

April 2026 Company Data Cube Release 

Contact Email Accuracy: Company Domain Validation 

Applications 

GTM Studio 

Run Logs in Studio 

Expand your match rates with more CSV mapping fields in GTM Studio Audiences 

Audience Lookup brings columns from any Audience or uploaded CSV directly into your existing 
GTM Studio Audiences 

Contact ZoomInfo Sales or Request More AI Credits Directly from GTM Studio 

GTM Workspace 

Workspace Pulse Feed 

Action Item Tracking 

Meeting Based CRM Updates 

Ecosystem & Admin 

Data Privacy Controls 

Set up Business Context configuration 
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Data 
 
AI-Powered Title Classification 
 
ZoomInfo has added classification data to 24.1 million previously unclassified contacts — covering 
department, seniority, job function, and management level across Operations, Engineering, Sales, Marketing, 
Finance, IT, and more — so the filters your team relies on to find decision-makers and build campaign 
audiences now return a far more complete picture. Contacts without classification data don't appear in 
filtered searches at all, meaning valid prospects across these functions were invisible to seniority and 
department filters when their titles were unclassified. This includes international contacts with non-English 
job titles, who are now discoverable in search results for the first time. When contacts surface in WebSights 
or Copilot intent signals, they now carry department and seniority context; so instead of knowing only that 
someone from a target account visited your pricing page, you can see it was a VP-level contact in IT. For 
customers who receive ZoomInfo data deliveries, the 24.1 million newly classified contacts mean contact sets 
defined by department or seniority criteria are now more complete — more contacts qualify against those 
filters, so delivered files reflect a larger share of your true addressable market. 
 
Use Case Tags: Prospecting | Audience Development | Data Management | Account Insights | Total 
Addressable Market (TAM) | Ad Campaign Execution & ABM 
Primary Personas: SDRs | Demand Generation Managers | ABM Managers | Revenue Operations 
 

 
 
25 Million Newly Published Contacts 
 
Access 25 million newly published contacts in ZoomInfo including 13.3 million with supplemental email 
addresses, 8.5 million with mobile numbers, and 7.7 million with business email addresses — with the largest 
coverage gains in North America (11.5M) and Asia (1.85M). These contacts are immediately matchable, 
improving your enrichment match rates on your next job with no setup required. As ZoomInfo finds newer 
data on these contacts, records are automatically updated with richer details, so the coverage you access 
today keeps improving without any action on your end. 
 
Use Case Tags: Data Management, Prospecting, Audience Development  
Primary Personas: RevOps, Marketing Ops, SDRs, AEs 
 

 
 
Location Enrichment Now Identifies the Right Location More Accurately 
 
When you enrich a company record with a mailing address, say, a street address in Chicago, you can now be 
more confident you will get the correct Chicago office. Location enrichment through RingLead and 
ZoomInfo's Company Master Data Enrich API now identifies the right office location 24 percentage points 
more accurately, and the right company 12 percentage points more accurately. So territory assignments reach 
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the right office, CRM records reflect where buyers actually work, and ABM campaigns hit the correct location. 
Total match rates will decrease by 2-3% percent by design, as the engine now better predicts wrong matches, 
meaning that match you receive can be trusted more than ever for territory routing, campaign targeting, and 
CRM updates 
 

Action required for some users: Legacy EverString fields including zi_es_location_id and zi_es_ecid, as 
well as Franchisor fields (zi_c_franchisor_*) are no longer populated. Review your CRM field mappings 
to avoid empty fields in Salesforce or connected systems. 

 
Use Case Tags: Data Management, Territory Design and Segmentation, Prospecting, Account Insights 
Primary Personas: Revenue Operations, Account Executives / Account Managers, SDRs / BDRs 
 

 
 
April 2026 Company Data Cube Release 
 
The April 2026 Company Data Cube delivers three major improvements: the largest industry reclassification in 
ZoomInfo's history across all 20 million Tier A companies, verified headquarters location coverage expanding 
to 79.7% of Tier A, and a new Location Verification Companion Table available for immediate opt-in. 
What's New in This Release: 

●​ Industry Classification Upgrade: ZoomInfo's Research team validated and applied updated industry 
classifications to 71.5% of Tier A companies, with more than 80% of changes confirmed as 
improvements. If your team uses industry filters in routing rules, scoring models, or audience 
segments, review those configurations after April 15. 

●​ Location Quality Improvements: Verified HQ location coverage has grown from approximately 45% to 
79.7% (15.9 million companies), with 21.1 million low-confidence records removed and a net Tier A 
count of 20.1 million (-2.4%). This is quality enforcement, not data loss. Accounts remaining in Tier A 
are more reliable for territory planning and routing than before. 

●​ Location Verification Companion Table (NEW — Opt-In): Delivers address verification status and 
date for approximately 198 million location records, enabling confidence-based filtering in your 
territory and routing workflows.  

●​ Additional Updates: EGR Companion Table updated with a significantly higher fill rate; 
franchise-related fields cleaned across approximately 500K companies. 

Access: All improvements apply automatically to DaaS customers. The Location Verification Companion Table 
requires opt-in through your CSM or DaaS team. Platform and Copilot customers receive updated underlying 
data automatically. 
Use Case Tags: Data Management, Account Prioritization, Territory Design and Segmentation, Total 
Addressable Market (TAM), Account Insights, Prospecting, Lead Management 
Primary Personas: Revenue Operations, Sales Operations, Marketing Operations, Account Executives, SDRs 
 

 
 
Contact Email Accuracy: Company Domain Validation 
 
Contact emails in ZoomInfo are now more accurately tied to the companies your contacts work for, reducing 
the risk of bounces from domain-mismatched addresses that damage sender reputation over time. A 
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large-scale reprocessing of 6 million+ contact records removed emails incorrectly assigned to the wrong 
company domain, where contacts at one company were carrying email addresses belonging to an entirely 
different organization, with correct-domain replacements applied where available. The improvement is live 
across all ZoomInfo products, integrations, and exports automatically, with no action required. 
 
Use Case Tags: Data Management, Prospecting, Ad Campaign Execution & ABM  
Primary Personas: SDRs, Demand Generation Managers, Marketing Operations Specialists 
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Applications 

 
GTM Studio 
 
Run Logs in Studio 
 
Track every enrichment run in GTM Studio Audiences — see exactly what processed, what failed, how long it 
took, and how many AI credits were consumed, all without digging through individual rows. Access run history 
at the Audience, Sheet, or Column level, filter by column, status, team member, or date range, and export any 
view as a CSV for internal auditing. Scheduled automated refresh runs are included, so when you come back 
after an overnight refresh, you can see precisely what happened. 
 

 
 
Expand your match rates with more CSV mapping fields in GTM Studio Audiences 
 
CSV uploads in GTM Studio Audiences now support the same full set of matching fields available across 
ZoomInfo — including LinkedIn URL, LinkedIn Member ID, hashed email, mobile phone, and more. For 
contacts, this means you can now map LinkedIn profile URLs during upload, which significantly improves 
match rates for lists where LinkedIn is the primary identifier. For companies, additional fields like stock ticker 
symbol, IP address, metro area, and social profiles are now available as mapping inputs. 
 

 
 
Audience Lookup brings columns from any Audience or uploaded CSV directly into your existing GTM 
Studio Audiences 
 
Audience Lookup brings columns from any Audience or uploaded CSV directly into your existing GTM Studio 
Audiences so event attendee lists, product usage metrics, territory assignments, and other external data can 
enrich the account segments you've already built. Select a source Audience, choose up to 15 columns, and 
match on any shared identifier like ZoomInfo Company ID or company domain to pull that data in as filterable, 
sortable columns. Find it in the Enrich panel under Formula & Transform. 

 
 
Contact ZoomInfo Sales or Request More AI Credits Directly from GTM Studio 
 
GTM Studio users on the 10K plan can now contact the ZoomInfo sales team or request more AI credits 
directly from the product. A new Contact Sales option in the navigation header lets users submit a request 
with one click and receive instant confirmation that a ZoomInfo expert will be in touch. When the account's 
2,000 AI credit allowance is reached, non-admin users can request additional credits from their admin 
through a built-in in-product prompt — keeping enrichment workflows moving without leaving GTM Studio. 
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GTM Workspace 

 
Workspace Pulse Feed 
 
Check your Pulse Feed daily for actionable intelligence across your accounts. One unified surface for sellers to 
discover and execute key jobs to be done. In this first phase, the pulse feed delivers temporal account and 
contact signals for your target accounts, all previously disparate across multiple surfaces within Workspace. 
Execute contextual AI actions directly from the feed such as generating emailing, or analyzing the impact of 
key signals on your customers and opportunities. 
 

 
 
Action Item Tracking 
 
Action items automatically extracted from Chorus calls can now be tracked and marked complete directly 
from a new Action Items page. View all your meeting action items in one place, filter by assignee or account, 
click play to jump to the exact moment the action was discussed, and check off items as you complete 
follow-ups. This eliminates the manual task of copying action items into separate tracking systems and 
ensures nothing falls through the cracks after customer conversations. 
 
Use Case Tags: Meeting Follow-Up, Task Management, Conversation Intelligence, Accountability 
Primary Personas: Account Executives, Account Managers 
 

 
 
Meeting Based CRM Updates 
 
Chorus now analyzes discovery and qualification calls to automatically populate MEDDIC, MEDDPICC, BANT, 
or SPIN fields in your CRM. After any recorded meeting, click "Check for CRM Updates" to generate 
AI-extracted framework values based on the conversation, review and edit suggested updates in a preview 
modal, then approve to write changes directly to your CRM opportunity fields in Salesforce, HubSpot, or 
other supported CRMs. Admins configure which framework to use and map fields once; reps can also trigger 
updates directly from Slack meeting recap notifications without logging into Chorus. 
 
Use Case Tags: Sales Methodology, CRM Automation, Meeting Intelligence, MEDDIC/MEDDPICC, Deal 
Qualification 
Primary Personas: Account Executives, Sales Managers 
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Ecosystem & Admin 
 
Data Privacy Controls 
 
Admins can now upload large domain lists via CSV in a single step and edit existing entries inline, eliminating 
the manual, entry-by-entry work that organizations managing multiple subsidiaries, recent acquisitions, or 
large vendor networks face when configuring or updating privacy settings. The redesigned page also clearly 
separates how the Ignore list and Block list behave: the Ignore list filters contacts from view while the Block 
list permanently deletes all historical data and cannot be undone, making this especially critical for compliance 
teams in regulated industries where choosing the wrong list type carries real risk, with a confirmation modal 
ensuring that distinction is never missed. Available now in the ZI Admin Portal / GTM Studio with no setup 
required. 
 
Use Case Tags: Data Management, Administration & Setup 
Primary Personas: RevOps Admins, Sales Ops Admins, IT / Compliance Admins 
 

 
 
Set up Business Context configuration 
 
Set up GTM Studio's AI to understand your business with the new Business Context configuration workspace. 
Business Context brings together company overview, product catalog, competitor intelligence, and signal 
setup in one place—previously spread across multiple disconnected settings pages that made 
comprehensive onboarding tedious. Document your product offerings (value propositions, pain points, proof 
points etc for each), identify competitor companies, define strategic priorities, and configure domains and 
intent topics that GTM Studio's AI uses to generate personalized account insights, targeted emails, and 
intelligent play recommendations. Access Business Context from the left navigation in GTM Studio during 
customer onboarding sessions. 
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March 17, 2026 ZoomInfo Release 
Data 

AI-Powered Title Classification 

Applications 

GTM Studio 

GTM Studio is now a dedicated standalone experience, separated from the Admin Portal 

Welcome Wizard (New User Onboarding) 

Precreated Audiences per Tenant 

Consolidated Actions Button (Enrich + Activate) 

Enrich Modal Recategorization 

Improved Audiences Controls 

Reduce Clicks to Add a Column 

AI Data Agent Redesign 

Improve JSON Object UX 

Add GTM Studio Audience records to Salesforce Campaigns as Campaign Members during export 

Export GTM Studio Audiences directly to Salesloft with Cadence enrollment 

Export GTM Studio Audiences directly to Outreach with Sequence enrollment 

Customize CRM Lookup 

GTM Studio: Cloud Data Share - Google Big Query 

Per-User AI Action Credit Limits [Release Date: 3/24] 

Use in AI & Use in Formula from Column Header 

Copilot 

Copilot Feed: Expanded Coverage, Signal Filtering & Pipeline Creation 

Ecosystem & Admin 

Prioritize Sync Health Check 

Automated WebSights & Account Fit Score CRM Sync 
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Data 
AI-Powered Title Classification 
 
ZoomInfo now classifies significantly more job titles — adding department data to 3 million previously 
unclassified contacts that had no classification before — so the filters your team uses to find decision-makers 
and build campaign audiences return a far more complete picture. Contacts without classification data don't 
appear in filtered searches at all, meaning valid decision-makers were invisible to seniority and department 
filters when their titles were unclassified — including contacts with non-English job titles, who are now 
discoverable in search results for the first time.  
 
When contacts surface in WebSights or Copilot intent signals, they now carry department and seniority 
context. For customers who receive ZoomInfo data deliveries, expanded title classification means contact 
sets defined by department or seniority criteria are now more complete — more contacts qualify against 
those filters, so delivered files reflect a larger share of your true addressable market. 
 
Use Case Tags: Prospecting | Audience Development | Data Management | Account Insights | Total 
Addressable Market (TAM) | Ad Campaign Execution & ABM 
Primary Personas: SDRs | Demand Generation Managers | ABM Managers | Revenue Operations 
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Applications 

 

GTM Studio 
 
GTM Studio is now a dedicated standalone experience, separated from the Admin Portal 
 
Users with a GTM Studio license access a focused workspace — Audiences, GTM Configuration, and the 
Connections and GTM Data Model sections of Integrations — without the ability to modify user management, 
security settings, or admin-only integration features. Admins can now provision GTM Studio users in a single 
step: assign the license and users land directly in GTM Studio, with no custom role configuration required. 
 
Use Case Tags: Administration & Setup, Audience Development, Data Management 
Primary Personas: Administrators, Revenue Operations 
 

 
 
Welcome Wizard (New User Onboarding)  
 
New GTM Studio users now open to a guided welcome experience: a 90-second overview video followed by a 
personalized audience generation flow that builds starter lists for your company before you've clicked a thing. 
By the time you reach the Audiences page, there's already something to explore, enrich, and run. 
 
Use Case Tags: Administration & Setup, Audience Development, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 

 
 
Precreated Audiences per Tenant  
 
GTM Studio now greets first-time users with up to 3 personalized starter audiences already built for their 
company — generated by an AI agent that analyzes their company profile and conducts live web research to 
identify the most relevant target companies and contacts. Each audience is immediately clickable and ready 
to enrich, giving new users a concrete starting point instead of a blank slate. 
 
Use Case Tags: Audience Development, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 

 
 
Consolidated Actions Button (Enrich + Activate) 
 
GTM Studio Audiences now have a single Actions button that brings enrichment and activation together in 
one place. The Enrich tab surfaces context-aware quick options — including Enrich with AI, Firmographics, 
Waterfall contact data, and Buying Intent signals — with different suggestions for company versus contact 
audiences, while the Activate tab shows all your connected destinations with direct links to integration setup 
for anything not yet connected. 
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Use Case Tags: Audience Development, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 

 
 
Enrich Modal Recategorization 
 
The GTM Studio enrichment panel is now a persistent side pane with a reorganized category structure that 
makes it easier to find the right data option. AI-generated signals consolidate under a new Copilot Signals 
category, the most commonly used enrichments surface upfront in a Popular section, and calculated field 
options group under a new Formula & Transform category — so users can navigate the full enrichment library 
without needing to know how it was previously organized. 
 
Use Case Tags: Audience Development, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Improved Audiences Controls 
 
The four core controls in GTM Studio Audiences — Filter, Sort, Views, and Run Enrichment — are now 
displayed as dedicated buttons at the top of every list, making them immediately visible and discoverable 
without any guidance. A real-time status indicator alongside Run Enrichment shows whether background 
enrichment jobs are processing or complete. 
 
Use Case Tags: Audience Development, Data Management  
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Reduce Clicks to Add a Column  
 
When you add a ZoomInfo data column from the Popular enrichment section — firmographics, signals, job 
postings, contact counts, and more — GTM Studio now previews, saves, and runs the column automatically in 
one action. The column starts populating across your entire Audience as soon as you confirm your selection, 
so you can keep stacking enrichments without waiting for separate save and run steps. 
 
Use Case Tags: Audience Development, Data Management 
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
AI Data Agent Redesign 
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The AI Data Agent in GTM Studio now starts with your prompt. Select from suggested enrichment questions 
or write your own, click Next, and GTM Studio runs the data recommender and loads your first 10 preview 
rows simultaneously — landing you directly in the enrichment pane with results ready to inspect and save. 
 
Use Case Tags: Audience Development, Data Management 
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Improve JSON Object UX  
 
Complex data returned from enrichments — such as contact arrays from Find Buyers or nested CRM records 
— now opens in a dedicated dialog modal in GTM Studio, rather than rendering inline in the side pane. All the 
same actions are available (expand, scroll, add as column), and the larger modal format makes it easier to read 
and navigate dense nested data without losing your place in the enrichment workflow. 
 
Use Case Tags: Audience Development, Data Management 
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Add GTM Studio Audience records to Salesforce Campaigns as Campaign Members during export 
 
Add Contacts and Leads from GTM Studio Audiences directly to Salesforce Campaigns as Campaign 
Members during CRM export, keeping campaign attribution in sync with your GTM activity without any 
manual steps in Salesforce. This option appears during export once an admin enables Add to Campaign 
Member for the Contact or Lead object type in Admin Export Settings. 
 
Use Case Tags: Ad Campaign Execution & ABM, Audience Development, Data Management, Administration & 
Setup  
Primary Personas: Marketing Operations, Revenue Operations 

 
 
Export GTM Studio Audiences directly to Salesloft with Cadence enrollment 
 
Export your GTM Studio Audiences directly to Salesloft — as Accounts, People, or both — and immediately 
enroll People into active Cadences in a single export, with the option to map AI-generated emails directly to 
Cadence email templates for personalized outreach at scale. Build lists using intent signals, buying signals, 
and ZoomInfo data, then push directly to Salesloft with owner assignment and field mapping — no manual 
CSV exports required. 
 
Use Case Tags: Audience Development, Data Management, Administration & Setup  
Primary Personas: Marketing Operations, Revenue Operations 
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Export GTM Studio Audiences directly to Outreach with Sequence enrollment 
 
Export your GTM Studio Audiences directly to Outreach — as Accounts, Prospects, or both — and enroll 
Prospects into active Sequences in the same export, with the option to map AI-generated emails directly to 
Sequence templates for personalized outreach at scale. Build targeted lists using buying signals, AI-generated 
columns, and ZoomInfo enrichment, then push to Outreach with owner assignment and field mapping in a 
few clicks. 
 
Use Case Tags: Audience Development, Data Management, Administration & Setup  
Primary Personas: Marketing Operations, Revenue Operations 

 
 
Customize CRM Lookup 
 
Enrich non-CRM workbooks with CRM data by matching on any field, not just ZoomInfo IDs. When working 
with ZoomInfo, CSV, or Snowflake workbooks that lack ZoomInfo IDs, map any workbook column to any CRM 
field for lookup—enabling CRM enrichment using email, domain, phone, or any other shared identifier. Perfect 
for enriching trade show lists, webinar attendees, or partner data with CRM owner assignments, opportunity 
data, and custom fields. The default ID-to-ID matching remains unchanged; this adds optional flexibility for 
more accurate, complete CRM enrichment. 
 
Use Case Tags: Audience Development, Data Management, Administration & Setup  
Primary Personas: Marketing Operations, Revenue Operations 
 

 
 
GTM Studio: Cloud Data Share - Google Big Query 
 
Your GTM Studio audiences now export directly to your Google BigQuery warehouse on demand, eliminating 
the back-and-forth coordination and manual delivery requests required every time your team needed fresh 
data.. 
 
Here's what changes: Your data science team trains lead scoring models combining ZoomInfo intent signals 
with your product usage patterns to identify high-propensity accounts 5-7 days earlier than competitors. Your 
marketing operations team builds Customer 360 dashboards merging our firmographics with your support 
tickets and usage metrics—one SQL query instead of manual data wrangling across three tools. Your revenue 
analysts set up automated territory assignments that trigger when accounts hit your ICP criteria, with fresh 
ZoomInfo intelligence available whenever they need to refresh their warehouse data. 
 
This solves the core problem blocking your GTM speed: your intelligence is fragmented across tools, forcing 
your teams to combine data before they can analyze it manually. Now ZoomInfo data flows into your 
warehouse, where your teams already work—training models, building dashboards, running the SQL queries 
that power your business. ZoomInfo becomes part of your data infrastructure, not a separate tool requiring 
manual exports. 
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Available now in Customer Early Access for GTM Studio customers with Google BigQuery environments. Your 
GTM Studio admin, who has warehouse admin access, configures the connection once through Admin Portal 
> Cloud Data Share, then runs on-demand exports whenever updated data is needed. Handles up to 200,000 
records per export. Included with GTM Studio—no additional SKU required.  
 
Use Case Tags: Data Management, Account Prioritization, Territory Design & Segmentation, Audience 
Development, Account Insights 
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Per-User AI Action Credit Limits [Release Date: 3/24] 
 
Admins can now set individual AI Action Credit limits per user in User Management — the same place you 
already manage Data Credit limits — so one power user running automated workflows can't exhaust the 
credits your entire team depends on. All users default to unlimited, so configure limits for any user whose 
consumption you want to cap. If a user hits their limit mid-action, a built-in buffer lets their final task complete 
before access is paused, and admins can restore access instantly by adjusting the limit directly in User 
Management — no support ticket needed. 
 
Use Case Tags: Administration & Setup, Data Management 
Primary Personas: RevOps Managers, IT Admins 
 

 
 
Use in AI & Use in Formula from Column Header 
 
Build AI enrichments and formulas from any column in GTM Studio Audiences without switching contexts. 
The column header menu now includes "Use in AI" and "Use in Formula" shortcuts — both open the relevant 
enrichment panel with that column pre-loaded as context or input, so you can move from data to insight in 
fewer clicks. 
 
Use Case Tags: Enrichment, AI Data Agent, Formula Attributes, Audiences, Usability 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
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Copilot 
 
Copilot Feed: Expanded Coverage, Signal Filtering & Pipeline Creation 
 
The Copilot feed now surfaces up to 1,000 account signals per day — 10x the previous limit — so a seller 
with 10,000 target accounts sees coverage across up to 1,000 accounts each day instead of 100. More 
signals only matter if you can focus them, so you can now filter by any of 30+ signal types across six 
categories to match your feed to your motion: SDRs can prioritize intent spikes, funding raises, and new 
executive hires; renewal AEs can surface competitive research and contact departures; expansion sellers can 
zero in on anomalous hiring and earnings signals. CRM-connected sellers also get a new "Companies with No 
Open Opportunities" view — a pre-built filter that surfaces target accounts with active signals and no open 
pipeline, so you can find new deals within your existing book without manually cross-referencing your CRM. 
Available now in Copilot Advanced and Copilot Enterprise, default activated; the pipeline view requires CRM 
connection. 
 
Use Case Tags: Account Prioritization, Prospecting, Account Insights, Up-Sell & Cross-Sell Identification, Deal 
Management 
Primary Personas: AE/AM (Enterprise & Mid-Market), SDR, Field Seller 

●​ Demo Video 
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Ecosystem & Admin 
 
Prioritize Sync Health Check 
 
The Prioritize Sync Health Check gives Salesforce and HubSpot admins real-time visibility into the seven 
permissions Prioritize Sync needs — from API Access to Custom Field Creation — so when something is 
blocked, you can see exactly what to fix and restore your Account Fit Scores and WebSights data flow in 
minutes without a support ticket. Previously, missing CRM permissions caused sync to fail silently with no 
indication of root cause, turning what should have been a quick fix into a 3-5 day support process. The Health 
Check panel is automatically available in your Prioritize Sync settings in the ZoomInfo admin portal — no 
activation needed. 
 
Use Case Tags: Data Management, Administration & Setup, Account Prioritization 
Primary Personas: CRM Admin (Salesforce / HubSpot), RevOps / Sales Ops 
 

 
 
Automated WebSights & Account Fit Score CRM Sync 
 
Stop manually exporting WebSights data every day. When engagement intelligence is trapped in point tools 
requiring manual exports, GTM teams lose competitive advantage—sales can't act on high-intent signals 
while accounts are actively evaluating. 
 
Copilot customers with WebSights (website visitor tracking) and Account Fit Score (predictive ICP matching) 
can now enable automated daily sync to Salesforce and HubSpot with one click in Admin Portal. This brings 
Copilot to parity with ZoomInfo Marketing's automated sync capabilities, unifying GTM intelligence delivery 
across the platform. Revenue Operations and Marketing Operations teams can enable this once for their 
entire organization—then sales teams, managers, and marketers all see updated engagement and fit data 
automatically where they already work.  
 
Sales managers can build reports showing which target accounts in each territory are actively engaged. 
Marketing Operations can create audiences based on accounts matching specific engagement patterns and 
fit thresholds. This unified intelligence enables faster GTM execution: prioritize outreach to accounts actively 
researching your solution, reach engaged prospects before competitors, and eliminate data fragmentation 
that slows decision-making. 
 
Use Case Tags: Data Management, Account Prioritization, Prospecting, Audience Development, Ad Campaign 
Execution & ABM, Account Insights 
Primary Personas: Revenue Operations, Marketing Operations 
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February 17, 2026 ZoomInfo Release 
Data 

Connect ZoomInfo to Claude and Other LLMs through ZI MCP 

10M Personal Email Expansion 

Mobile Phone Coverage Expansion 

URL-Only Company Creation 

Applications 

GTM Studio 

Waterfall Enrichment: 7M More Alternative Direct Dials Now Available (77M Total) 

WebSights Identity Data Webhook 

Copilot 

Websights CRM Account Filtering for Dynamics and HubSpot 

Microsoft Dynamics Filter for Intent 

Unique Intent Topic Recommendations 

Talent 

Mailbox Connection Management 

Ecosystem & Admin 

Flexible CRM Import 
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Data 
 
Connect ZoomInfo to Claude and Other LLMs through ZI MCP 
 
Access ZoomInfo's contact data and account intelligence directly in Claude and other AI assistants. Ask "Who 
should I contact at Salesforce about this partnership?" and get real names, titles, and contact information 
instead of generic research advice. Ask "Show me companies hiring sales leaders in fintech" and get a 
qualified target list. ZoomInfo's comprehensive GTM data—spanning 70M+ contacts, buying signals, and org 
charts—powers your AI with actionable intelligence, not public web summaries. Connect through Claude's 
connector settings by adding the ZoomInfo connector and logging in with your existing ZoomInfo 
credentials. 

●​ Demo Video 
 
Use Case Tags: Account Insights, Prospecting, Audience Development, Data Management 
Primary Personas: Revenue Operations, Sales Development Representatives (SDRs), Account Executives 
(AEs), Demand Generation Managers 
 

 
 
10M Personal Email Expansion 
 
Reach 10 million more contacts through personal email addresses now available in ZoomInfo, increasing total 
coverage from 74 million to 78 million contacts with freemails. We've added first-time personal email 
coverage to 4 million contacts and 5.3 million additional email options for waterfall enrichment when your 
primary outreach gets no response.  
 
Coverage expanded specifically on high-value targets: 3 million new primary personal emails on North 
American contacts (5% increase in this region) and 3 million on Manager+ decision-makers most frequently 
targeted by enterprise sales. Available now for Sales/Copilot customers with Advanced+ or Elite+ packages 
plus supplemental email SKU, Marketing Advertising Advanced+ users, and all Talent users. 
 
Use Case Tags: Data Management, Prospecting, Audience Development, Lead Management, Account Insights 
Primary Personas: Sales Development Representatives (SDRs), Account Executives/Account Managers, 
Marketing Operations Specialists, Demand Generation Managers 
 

 
 
Mobile Phone Coverage Expansion 
 
Find working mobile numbers on at least 5% more contacts in your list uploads and CRM enrichments, 
enabling phone outreach on prospects and candidates.  
 
ZoomInfo now provides 9 million additional verified mobile numbers (6M primary, 3M alternative) that enrich 
your matches across all workflows—when you upload a list or run a CRM enrichment job.  
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In Reachout, contacts that previously showed "not actionable" may now include mobile numbers you can call 
immediately, buying committee searches return more contacts with mobiles, and GTM Studio automatically 
provides backup mobile numbers when primary contacts fail without requiring manual searches.  
 
Available now to all customers with mobile entitlements across Sales, Talent, GTM Studio, and Enterprise 
packages without any setup required—with strongest coverage gains in North America (+5.4M mobiles), with 
North America receiving the largest improvements (+5.4M total mobile numbers), followed by significant 
gains in Asia (+623K), Europe (+240K), Australia (+133K), Africa (+112K), and South America (+96K).  
 
Use Case Tags: Data Management, Prospecting, Account Insights, Up-Sell & Cross-Sell Identification 
Primary Personas: SDRs/BDRs, Revenue Operations/Sales Operations, Account Executives/Account 
Managers  
 

 
 
URL-Only Company Creation 
 
Find and target previously unmapped companies with expanded ZoomInfo coverage of emerging businesses 
and niche market segments. Research teams now scale company additions through automated URL-based 
creation that extracts firmographic data—including year founded, headquarters location, and country 
information—strengthening the data foundation that powers your TAM identification, account searches, and 
territory planning. Built-in duplicate prevention and intelligent validation ensure database integrity while 
continuously expanding your addressable market visibility. 
 
Use Case Tags: Total Addressable Market (TAM), Data Management, Account Prioritization, Territory Design 
and Segmentation, Prospecting 
Primary Personas: Revenue Operations / Sales Operations, Marketing Operations, Sales Development 
Representatives (SDRs), Account Executives (AEs) 
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Applications 

 

GTM Studio 
 
Waterfall Enrichment: 7M More Alternative Direct Dials Now Available (77M Total) 
 
Alternative direct dials now cover 77 million contacts (expanded from 70 million), providing backup phone 
numbers. When you encounter a failed primary number in GTM Studio Audiences, visual indicators show when 
alternatives are available - click to access backup options from 40+ pre-evaluated vendors automatically. This 
expansion adds 5.4 million contacts in North America, plus additional coverage in South America and Asia.  
 
Note: Alternatives are backup options, not replacements - they're expected to have lower success rates but 
provide more connection attempts on high-value targets. Available now to all GTM Studio Audiences users. 
 
Use Case Tags: Data Management, Prospecting, Lead Management 
Primary Personas: SDRs, Account Executives, Marketing Operations, Revenue Operations 
 

 
 
WebSights Identity Data Webhook 
 
Build real-time lead scoring, person-level attribution models, and custom engagement workflows by receiving 
complete visitor intelligence automatically in your analytics and marketing systems. WebSights Identity Data 
Webhook delivers company data and individual person profiles for US visitors—110+ enriched attributes, 
complete visitor session metadata (URL, duration, engagement signals), and comprehensive person 
profiles—within approximately one minute of each website visit as structured JSON to platforms like Tableau, 
Marketo, or your custom data warehouse. Available now to WebSights customers, charging bulk credits only 
for successful identifications through the Workflows interface in Admin Portal or GTM Studio. 

●​ Demo Video 
 
Use Case Tags: Data Management, Lead Management, Account Insights, Prospecting 
Primary Personas: Marketing Operations, Revenue Operations, Demand Generation Managers 
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Copilot 
 
Websights CRM Account Filtering for Dynamics and HubSpot 
 
Filter Websights to show only accounts in your Dynamics or HubSpot CRM, eliminating time spent daily 
manual cross-referencing. SDRs toggle to exclude their assigned accounts and instantly see available 
prospects. Account managers and account executives filter to owned accounts only, spotting expansion 
opportunities when existing customers research new solutions and responding in hours instead of days. 
Available in the Websights tab with one-click activation once your CRM is connected. 

●​ Demo Video 
 
Use Case Tags: Prospecting, Account Insights, Up-Sell & Cross-Sell Identification, Data Management 
Primary Personas: SDRs, Account Executives, Account Managers 
 

 
 
Microsoft Dynamics Filter for Intent 
 
Dynamics users can now filter intent to show only their CRM accounts - bringing them to feature parity with 
Salesforce and HubSpot users. An SDR managing hundreds of accounts toggles the filter and instantly sees 
the ones showing buying signals, eliminating time spent manually cross-referencing. Account managers spot 
expansion opportunities the moment existing customers research new solutions, responding in hours instead 
of days. Available in the Intent tab once Dynamics is connected - filter appears automatically with one-click 
activation. 

●​ Demo Video 
 
Use Case Tags: Prospecting, Account Insights, Up-Sell & Cross-Sell Identification, Account Prioritization 
Primary Personas: SDRs/BDRs, Account Executives, Account Managers, Sales Leaders 

 

 
Unique Intent Topic Recommendations 
 
Spot high-priority intent topics instantly—each topic now appears once instead of cluttering your view with 
duplicates. When "ABM platform" was recommended 5 times across different weeks, you now see it once and 
can immediately decide whether to act. Click any topic to view its complete six-month recommendation 
history and identify persistent buying signals that warrant aggressive outreach versus one-time 
mentions—helping your team prioritize accounts more strategically and reach buyers faster. Available now for 
all Copilot and ZI Marketing customers. 

●​ Demo Video 
 
Use Case Tags: Account Prioritization, Prospecting, Account Insights, Lead Management 
Primary Personas: RevOps, Sales Ops and Marketing Ops, Demand Generation Managers, ABM Managers 
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Talent 
 
Mailbox Connection Management 
 
Connect, disconnect, and view your Gmail or Office365 mailbox status directly from Settings > 
Integrations—giving you complete control to switch between email accounts, reconnect when 
troubleshooting email sending issues, or quickly revoke access for security requirements. Find your Gmail and 
Office365 integration cards in Settings > Integrations alongside your other integrations; disconnection takes 
seconds with a confirmation dialog that warns scheduled emails will be deleted. 
 
Use Case Tags: Administration & Setup, Prospecting 
Primary Personas: SDRs, Account Executives/Account Managers, Revenue Operations 
 

 
 

Ecosystem & Admin 
 
Flexible CRM Import 
 
ZoomInfo updated our CRM Import processes so all ZoomInfo products run on the same clean set of GTM 
Data—the GTM Data Model—regardless of your CRM setup. Map custom fields to replace our default field 
mapping and power Advanced Search with your actual data structure, or map custom CRM objects for GTM 
Studio to analyze specialized business data. Create Import Rules to automatically exclude partners, test 
accounts, or restricted records—changes apply retroactively to all existing records within 24 hours. The new 
GTM Data Model page shows exactly which objects and fields ZoomInfo is using from your CRM, Email, 
Calendar, and Meeting sources. 

●​ Demo Video 
 
Use Case Tags: Data Management, Account Prioritization, Up-Sell & Cross-Sell Identification, Territory Design 
and Segmentation 
Primary Personas: Revenue Operations, Sales Operations 
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January 21, 2026 ZoomInfo Release 
Data 

January 2026 Company Data Cube Release 

14.4M US Mobile Numbers Expansion 

14.7M Personal Email Coverage Expansion 

Applications 

GTM Studio 

Pre-Built Enrichment Connectors for Audience Building 

Waterfall Data Enrichment: Coverage Increase 

Cell-Level Enrichment Status Indicators 

Stop waiting for data enrichment to finish before you can work 

Adobe Analytics Integration for WebSights 

Ecosystem & Admin 

New License Type to Ingest Email & Calendar Engagements 

Configuration Change Tracking (Admin Trail) 
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Data 
January 2026 Company Data Cube Release 
 
The January 2026 Company Data Cube delivers approximately 1.8 million new companies to support market 
expansion, international growth strategies, and comprehensive TAM analysis. This release strengthens global 
coverage with a strategic focus on premium Tier A company quality and European market depth, enabling 
revenue teams to identify prospects in previously underserved international markets with complete 
firmographic intelligence. 
 
What's New in This Release: 

●​ Orphaned URL Company Creation: 1.24 million new companies created from previously unmatched 
business URLs—primarily international (93%) with 900K Tier A additions. 

●​ International Expansion: 485,000 new international companies added (340K premium Tier A) through 
data partnerships in EMEA, LATAM, and APAC. 

●​ Premium Quality Focus: 741,000 net new Tier A companies (now 14.1% of database) with complete 
firmographic profiles including verified URLs, employee counts, revenue, addresses, and industry 
classifications. 

●​ European Market Leadership: 75% of Tier A growth in European markets—Germany (198K), 
Netherlands (113K), France (99K). 

●​ Data Quality Improvements: 2.3 million companies edited in Q4 2025 with updates to names (828K), 
descriptions (964K), industries (503K), and addresses (328K). 

 
Access: These companies are available immediately in ZoomInfo search, lists, workflows, and CRM 
integrations. 
 
Use Case Tags: Total Addressable Market (TAM), Data Management, Account Prioritization, Account Insights, 
Territory Design and Segmentation, Prospecting, Lead Management 
Primary Personas: Revenue Operations, Sales Operations, Account Executives, SDRs, Marketing Operations 
 

 
 
14.4M US Mobile Numbers Expansion 
 
Access 14.4 million new US mobile numbers across ZoomInfo contacts. Call and text prospects on their 
mobile phones instead of being stuck with email-only outreach when mobile numbers weren't available. 
Available immediately to all customers with mobile entitlements with no setup required—mobile numbers 
appear automatically in search results, CRM enrichment, and sales engagement platforms. 
 
Use Case Tags: Data Management, Prospecting, Lead Management 
Primary Personas: Sales Development Representatives (SDRs), Account Executives (AEs), Account Managers 
(AMs) 
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14.7M Personal Email Coverage Expansion 
 
Access expanded personal email coverage by 14.7 million contacts to match personal emails to business 
profiles and provide multiple personal email options per contact for waterfall enrichment. For existing 
contacts in your database, ZoomInfo surfaces Email 2 and Email 3 options when requested through GTM 
Studio's waterfall enrichment, giving you backup contact channels when primary methods prove ineffective. 
Available automatically for Sales and Copilot customers with Advanced+ or Elite+ packages and supplemental 
email SKU, all TalentOS users, Marketing Advertising Advanced+ users, and GTM Studio users. 
 
Use Case Tags: Audience Development, Ad Campaign Execution & ABM, Lead Management, Account 
Insights, Prospecting, Multi-Channel Prospecting 
Primary Personas: Demand Generation Managers, Account Executives (AEs), Sales Development 
Representatives (SDRs), Account Managers (AMs), Marketing Operations Specialists, Revenue Operations 
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Applications 

 
GTM Studio 
 
Pre-Built Enrichment Connectors for Audience Building 
 
Enrich target audiences with technographic data, funding intelligence, email verification, and company 
insights from 25 pre-built connectors, no IT setup or API configuration required. Identify companies using 
specific technologies with HG Insights, verify email deliverability with Hunter before campaigns, or prioritize 
high-growth prospects using Crunchbase funding data. Access in GTM Studio → Integrations → Connections, 
or within any audience via Add Enrichment → Connectors. 
 
Use Case Tags: Data Management, Audience Development, Account Prioritization, Ad Campaign Execution & 
ABM 
Primary Personas: Revenue Operations, Marketing Operations 

 
 
Waterfall Data Enrichment: Coverage Increase 
 
Waterfall enrichment now includes additional contact methods beyond primary attributes—alternative mobile 
phones, work emails, personal emails, and direct lines that were previously withheld for being below our 
accuracy standards. When your primary email bounces or phone disconnects, click once to see their personal 
and 2 mobile numbers to try next. For over 50 million contacts, you now gain contact paths that weren't 
accessible before, understanding these alternatives are lower quality (which is why we didn't show them first), 
but having a backup option beats having no option when reaching specific high-value targets matters. 
 
When to use this: Strategic account pursuits and high-value contacts where reaching the individual justifies 
higher bounce risk. For high-volume campaigns, stick with primaries to maintain sender reputation. 
 
Use Case Tags: Prospecting, Data Management, Account Insights, Deal Management 
Primary Personas: Sales Development Representatives (SDRs), Account Executives (AEs), Account 
Managers, Marketing Operations, Demand Generation Managers 
 

 
 
Cell-Level Enrichment Status Indicators 
 
Know exactly what happened with each enrichment operation through clear cell status indicators. Cells now 
show "No results" when data wasn't found, "Issue found" with one-click retry for temporary errors, "Failed to 
load" for system issues, or blank when not yet processed—eliminating confusion about blank cells. Error 
states won't appear in your CSV or CRM exports, keeping your data clean. 
 
Use Case Tags: Data Management 
Primary Personas: Revenue Operations, Marketing Operations 
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Stop waiting for data enrichment to finish before you can work 
 
RevOps teams need speed and increased productivity to keep pace with GTM demands, but waiting for 
column enrichment blocks essential workflows like building lists, adding data fields, or creating audience 
segments. Now workbook jobs run in the background automatically—find contacts, add enrichment columns, 
and build new queries while your data processes. Cancel any queued job before it starts if you accidentally 
run the wrong column or select too many rows (especially important for AI columns that consume credits). 
Track all jobs from the queue widget at the bottom of your workbook, with completed jobs clearing 
automatically after 5 seconds. 
 
Use Case Tags: Data Management, Account Prioritization, Audience Development 
Primary Personas: RevOps Managers, Marketing Operations, Sales Operations, Data Analysts 
 

 
 
Adobe Analytics Integration for WebSights 
 
WebSights now integrates with Adobe Analytics, automatically exporting company visitor data to your Adobe 
Analytics dashboards as visitors browse your website. The integration sends firmographic data including 
company name, revenue, employee count, industry, and location to your Adobe Analytics eVars (custom 
variables), eliminating manual CSV exports and data reconciliation. Set up by mapping your desired ZoomInfo 
fields to Adobe Analytics eVars in Admin Portal or GTM Studio (Configurations > Domains > Advanced 
Settings), enabling your analytics teams to build custom reports and segments using firmographic visitor 
intelligence from ZoomInfo's database—all directly within Adobe Analytics. Available January 2026 to all 
WebSights customers. 
 
Use Case Tags: Data Management, Account Insights, Audience Development 
Primary Personas: Marketing Operations, Marketing Analysts, Revenue Operations 
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Ecosystem & Admin 
 
New License Type to Ingest Email & Calendar Engagements 
 
Capture non-sales team engagement without full Copilot licenses. Assign sync licenses in User Management 
for complete account context—improving expansion timing and churn prevention. 10k of each license type 
included. 
 
Use Case Tags: Account Insights, Up-Sell & Cross-Sell Identification, Churn Risk Detection & Mitigation, Data 
Management 
Primary Personas: Revenue Operations, Sales Operations, Account Executives / Account Managers 
 

 
 
Configuration Change Tracking (Admin Trail) 
 
Troubleshoot RingLead configuration issues yourself by checking Admin Trail (Analyze > Admin Trail) to see 
what changed, who changed it, and what the settings were before. When tasks suddenly behave differently, 
you'll know immediately if a team member modified settings—like switching enrichment schedules from 
weekly to daily—and you can manually adjust it back using the before values, no support ticket needed. 
Admin Trail also maintains 30-day change history for operational audit documentation. 
 
Use Case Tags: Data Management, Churn Risk Detection & Mitigation 
Primary Personas: Marketing Operations 
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Dec 9, 2025 ZoomInfo Release 
Applications 

GTM Workspace 

Priority SFDC Fields 

Filter GTM Workspace Views by company ownership structure to apply the right sales motion to 
the right accounts 

Spot territory imbalances and performance risks instantly when you group accounts by rep, stage, 
or segment 

GTM Studio 

Waterfall Enrichment 

AI Data Agent for GTM Studio Audiences 

ROI Analytics Dashboard 

Self-Service Audience Data Share to Snowflake & Databricks 

Single column runs 

Copilot 

Cross-Platform Intent Cluster Synchronization 

Expanded Intent Cluster Capacity 

Multi AFS for Copilot Customers 

Chorus Custom Summary Templates 

Marketing 

Prioritize Sync Status & Error Handling 

Ecosystem & Admin 

Enhanced User Management 

Personalized Opt-Out List 
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Applications 
GTM Workspace 
 
Priority SFDC Fields 
 
Stop scrolling through hundreds of Salesforce fields to find the ones you actually use. ZoomInfo now shows 
your most relevant DFSC fields first when building lists, creating filters, or mapping data–prioritizing the fields 
your Salesforce admins already display on your object pages (like Account Owner, Customer Type, or Last 
Activity Date). Need a different field? Expand to see all available SFDC fields with one click.  
 
Use Case Tags: Data Management, Prospecting, Lead Management 
Primary Personas: Marketing Operations, Revenue Operations 
 

 
Filter GTM Workspace Views by company ownership structure to apply the right sales motion to the right 
accounts 
 
Sales teams can now filter their account lists in GTM Workspace (formerly SalesOS) by company ownership 
structure. Education sellers can create lists showing only universities and schools to focus on academic 
buying cycles and fiscal year timing. Government-focused reps can isolate federal, state, and local entities 
that require RFPs and compliance documentation. Enterprise AEs pursuing IPO-ready companies can filter for 
Public companies to prioritize accounts with sophisticated procurement and established buying committees. 
Find the Company Type field in your View filters to segment by organizational structure. 
 
Use Case Tags: Account Prioritization, Territory Design and Segmentation, Total Addressable Market (TAM), 
Prospecting 
Primary Personas: Account Executives, Sales Managers, Sales Development Representatives 
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Spot territory imbalances and performance risks instantly when you group accounts by rep, stage, or 
segment 
 
Front-line managers can now inspect their business across hundreds of accounts by grouping and 
immediately seeing account distribution—identify that one rep carries 45 accounts while another has 12, or 
that 60% of your pipeline sits in Stage 2 stalled deals. The filter menu opens automatically when you group, 
letting you drill into specific segments in seconds to address imbalances before they impact quota 
attainment. When you group accounts by Account Owner, Stage, Region, or any field in GTM Workspace, row 
counts display for each group without expanding, giving managers the visibility they need to balance 
workloads and identify risks fast. 
 
Use Case Tags: Territory Design and Segmentation, Deal Management, Account Insights 
Primary Personas: Sales Managers, Revenue Operations, Account Executives 
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GTM Studio 
 
Waterfall Enrichment 
 
Fill missing mobile phones and business emails in any Workbooks list with scored data from 40+ vendor 
sources, evaluating all available sources simultaneously to return the highest-confidence match—included at 
no additional cost in your Workbooks subscription. Right-click any Email or Mobile Phone column, select 
"Waterfall Enrichment," and fill gaps in your contact data to launch campaigns faster without exporting to 
external tools or accepting incomplete lists. Each enriched value displays its vendor source with logo for full 
transparency. 
 
Use Case Tags: Data Management, Prospecting, Audience Development 
Primary Personas: Revenue Operations, Sales Operations, SDRs/BDRs, Demand Generation Managers, 
Marketing Operations, Account Executives 
 

 
 
AI Data Agent for GTM Studio Audiences 
 
Ask questions in plain English to enrich lists, research accounts, generate personalized content, and analyze 
conversations across hundreds or thousands of accounts—pulling from ZoomInfo intelligence, your CRM, 
Snowflake, and the open web. Instead of manually searching for data points one account at a time across 
multiple tools, ask "Show me accounts with recent funding in healthcare" or "Write personalized emails for 
these contacts mentioning their CRM migration" and the agent delivers results in seconds, letting you 
prospect 10x more accounts in the same time. Access the agent through the AI icon or Cmd+K (Mac) / Ctrl+K 
(Windows)—conversational chat and basic ZoomInfo enrichment included, with advanced capabilities like 
web research and content generation consuming AI Credits (included in your base package). 
 
Use Case Tags: Data Management, Account Insights, Prospecting, Audience Development, Account 
Prioritization 
Primary Personas: SDRs (Sales Development Representatives), Account Executives, Revenue Operations, 
Demand Generation Managers 
 

 
 
ROI Analytics Dashboard 
 
Stop relying on spreadsheets, BI tools, and guesswork to calculate ZoomInfo’s ROI—see exactly how your 
ZoomInfo activities drive measurable revenue outcomes. The new ROI Analytics Dashboard shows how 
actions like interacting with contact and company details, acting on Copilot signals, and using AI features like 
emailer and Ask Copilot directly impact opportunity creation, deal progression, and closed-won revenue 
across your sales organization. 
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Measuring ZoomInfo's business value left gaps in mid-funnel and bottom-funnel correlation, making it difficult 
to justify renewals and platform investments. Now RevOps, sales leaders, and managers can filter by 
opportunity stages and types, interaction types, teams, and timeframes to see specific insights like which 
signal types drive highest win rates, how platform interactions correlate with deal size increases, and which 
team members are driving the most revenue. 
 
Available now in GTM Studio and Admin Portal for SalesOS and Copilot customers with connected CRMs 
(Salesforce, HubSpot) and Advanced Sync enabled. 
 
Use Case Tags: Deal Management, Account Prioritization, Churn Risk Detection & Mitigation, Data 
Management, Account Insights 
Primary Personas: Revenue Operations, Sales Operations 
 

 
 
Self-Service Audience Data Share to Snowflake & Databricks 
 
Your GTM Studio audiences now export directly to your Snowflake or Databricks warehouse on your 
schedule—eliminating the 3-14 day wait and 6-12 hours per month spent coordinating manual data delivery. 
 
This solves the core problem blocking your GTM speed: your intelligence is fragmented across tools, forcing 
your teams to manually combine data before they can analyze it. Now ZoomInfo data flows into your 
warehouse where your teams already work—training models, building dashboards, running the SQL queries 
that power your business. ZoomInfo becomes part of your data infrastructure, not a separate tool requiring 
manual exports. 
 
Available now in Customer Early Access for GTM Studio customers with Snowflake or Databricks 
environments. Your GTM Studio admin who has warehouse admin access configures the connection once 
through Admin Portal > Cloud Data Share, then schedules daily/weekly exports or runs them on demand. 
Handles up to 200,000 records per export. Included with GTM Studio—no additional SKU required. Support 
for S3, BigQuery, GCS, and Redshift coming H1 2026. 
 
Use Case Tags: Data Management, Account Insights, Up-Sell & Cross-Sell Identification, Territory Design and 
Segmentation 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
 

 
 
Single column runs  
 
Get data for specific fields first to make smarter enrichment decisions and control costs. Previously, running 
enrichment meant processing all columns across all rows—no way to enrich just one field first. Now click any 
column header and select "Run column" to enrich only that field across your entire dataset. Run a single 
column first, use that data to segment your audience, then run expensive AI enrichment only on the relevant 
segments. For example: Add a location column, run only that field to see where your contacts are, filter to 
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target regions, and run AI enrichment on only those specific segments—cutting unnecessary AI credit spend 
while building more precise audiences. 
 
Use Case Tags: Data Management, Audience Development, Account Prioritization 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
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Copilot 
 
Cross-Platform Intent Cluster Synchronization  
 
Keep sales and marketing aligned on target accounts by creating identical Intent Clusters in both Copilot and 
ZI Marketing—for example, when your RevOps team defines "Digital Transformation + Cloud Migration" as a 
priority buying signal, both teams now work from the exact same definition instead of slightly different 
versions. This prevents the misalignment that happened when the system forced you to modify topic 
combinations just to duplicate across platforms, causing marketing to target accounts based on different 
criteria than sales was tracking. Find the duplicate function in Intent Clusters (automatically enabled for 
both-product customers); clusters process within 24 hours. 
 
Use Case Tags: Account Prioritization, Audience Development, Account Insights 
Primary Personas: Revenue Operations, Marketing Operations, Demand Generation Managers 
 

 
 
Expanded Intent Cluster Capacity 
 
ABM Enterprise and Copilot Enterprise customers can now create up to 50 intent clusters (up from 10) so 
multi-product companies can give each business unit its own consolidated intent score—for example, 
enterprises with multiple product divisions like cloud services, collaboration tools, and CRM platforms can 
now give each team a single score showing buying interest for their specific products instead of tracking 
hundreds of individual topic alerts. Multi-product enterprises were hitting the 10-cluster limit, forcing ABM 
managers to either manually review overwhelming individual signals or create overly broad clusters that 
reduced targeting precision—now each product division sees one score indicating comprehensive buying 
interest across all their related topics, enabling 3-5x more personalized campaigns per division. 
 
Use Case Tags: Ad Campaign Execution & ABM, Audience Development, Account Insights, Account 
Prioritization 
Primary Personas: Revenue Operations, Marketing Operations, Demand Generation Managers 
 

 
 
Multi AFS for Copilot Customers 
 
Companies with multiple products or regions face a problem: single account fit scoring forces everyone to 
use the same prioritization. Your Enterprise team sees SMB accounts that are too small. Your SMB team sees 
Fortune 1000 accounts they'll never close. West Coast reps waste time on East Coast prospects. Each team 
needs different intelligence. 
 
Revenue operations teams can now create 3-5 separate fit score models—one per product, region, or 
segment. Configure each model using that team's actual closed-won deals in Admin Portal—typically 15-30 
minutes per model once ICP is defined. Within 24 hours, each sales team automatically sees only accounts 
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that match their specific ICP across Advanced Search, daily prospecting recommendations, and account 
intelligence. Your Enterprise rep selects "Enterprise Product AFS" from the dropdown and filters to "Great 
Fit"—getting a list of 500+ employee companies that actually buy that product. Your SMB rep selects "SMB 
Product AFS" and sees 50-200 employee companies. Your West Coast team sees California startup targets. 
Your East Coast team sees New York financial services targets. Same ZoomInfo platform, different relevant 
account lists for each team based on what they actually sell and who they actually close. 
 
Powered by ZoomInfo's comprehensive data foundation that enables accurate scoring across all your models 
simultaneously. Each model requires 50+ closed deals for training (100+ recommended for optimal accuracy). 
 
Available on December 16 at no additional cost for Copilot Advanced (3 models) and Copilot Enterprise (5 
models) through Admin Portal → Account Fit Score. 
 
Use Case Tags: Account Prioritization, Territory Design and Segmentation, Prospecting, Data Management 
Primary Personas: Revenue Operations, Sales Operations, Account Executives / Account Managers  
 

 
 
Chorus Custom Summary Templates 
 
Extract specific insights from calls in seconds instead of spending time re-listening to recordings. Default 
summaries provide general call recaps, but you need different insights for different situations—competitive 
intelligence before a product meeting, qualification details for pipeline reviews, sentiment analysis for at-risk 
accounts. Select from four ready-to-use templates (Meeting Recap, Demo, Customer Discovery, Account 
Review) in the Summaries dropdown on any meeting's Overview tab, and AI automatically generates your 
targeted summary. Admins can create additional custom templates to standardize insight capture across your 
team's specific methodologies. 
 
Use Case Tags: Account Insights, Prospecting, Deal Management 
Primary Personas: Account Managers / Account Executives, Sales Operations, Revenue Operations 
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Marketing 
 
Prioritize Sync Status & Error Handling 
 
Maintain continuous CRM data sync with instant visibility into sync health and self-service error resolution. 
Marketing Ops teams can now check Prioritize Sync status in minutes, identify exactly what needs attention, 
and resolve common issues like expired connections or rate limits themselves—keeping In-Market Scores, 
campaign metrics, and funnel stage data current without waiting for support diagnosis. This operational 
confidence enables building sophisticated automated workflows on reliable data foundations. Access sync 
status in Admin Portal > Integrations > [CRM] > Prioritize Sync tab. 
 
Use Case Tags: Data Management, Account Insights, Prospecting 
Primary Personas: Marketing Operations, Revenue Operations, Sales Operations 
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Ecosystem & Admin 
 
Enhanced User Management 
 
Find specific users instantly by combining filters like role and admin status—identify all inactive Account 
Executives or custom roles that can be retired. Add new users with a guided creation window that validates 
field entries as you type, so you know your setup is correct before saving. Available now in Admin Portal or 
GTM Studio under User Management > Users. 
 
Use Case Tags: Administration & Setup 
Primary Personas: Revenue Operations, Sales Operations 
 

 
 
Personalized Opt-Out List 
 
Access only opted-out contacts from your records under management—ZoomInfo automatically filters your 
opt-out list to show only relevant records requiring action instead of exposing you to tens of thousands of 
irrelevant PII records. This data governance improvement applies least access principles while reducing 
compliance processing from 2-4 hours monthly to 15-30 minutes, available now for all customers with records 
under management. 
 
Use Case Tags: Data Management, Audience Development, Lead Management, Prospecting 
Primary Personas: Revenue Operations, Sales Operations 
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Nov 18, 2025 ZoomInfo Release 
Data 

Enhanced Title Classification with ML 

Improved Local Addresses 

1.8 Million New International Mobile Numbers 

Applications 

GTM Workspace 

Combine and Customize Views with Manual Row Control 

Mobile Phone Access and Contact Masking in Views 

Priority Fields: Quick Filters in Views 

Discover What's Possible With One-Click GTM Workspace Actions 

Export to Outreach - GTM Workspace 

GTM Studio 

Signal-Based Workbook Creation 

Expanded Signal Enrichment 

Enrich Audiences with Job Posting data 

Audience List Activation to GTM Workspace 

Filter AI Credits Dashboard by User and Action Type 

ZoomInfo Copilot 

Admin-Defined Territory Assignment 

Chorus Automated Moments API 

Marketing 

WebSights AI Page Rank 

WebSights Automated Traffic Visibility 

Ecosystem & Admin 

Breached Credential Protection 

Data Sharing Page Updates 

Enhanced Performance Dashboard 
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Data 
 
Enhanced Title Classification with ML 
 
This improvement makes 10.2 million global contacts discoverable to customers for the first time by properly 
classifying thousands of previously unclassified job titles across ten critical business departments - including 
5.4 million Operations professionals, plus Medical & Health, Engineering, HR, Finance, Marketing, IT, Sales, 
Legal, and C-Suite roles. This comprehensive global coverage - 3.1 million US contacts, 1.6 million in Brazil, 0.5 
million in India, and strong presence across 180+ countries - enables market segmentation, territory design, 
and account penetration strategies across your entire GTM motion. Available now across all ZoomInfo 
products with no setup required. 
 
Use Case Tags: Data Management, Account Prioritization, Territory Design and Segmentation, Prospecting, 
Audience Development, Total Addressable Market (TAM), Account Insights 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Demand Generation Managers, 
Revenue Operations 
 

 
 

Improved Local Addresses 
 
Location data you can trust eliminates wasted prospecting on out-of-territory contacts. With post-pandemic 
remote work, the old assumption that contacts work where their company's office is located no longer holds 
true - we've replaced office assumptions with verified accuracy for 160 million contacts. For example, when 
you search for contacts in Charlotte, you now get people actually in Charlotte, not remote workers for 
Charlotte-based companies who live in Richmond. Territory-based sales teams find contacts truly in their 
regions, marketing teams target regional campaigns and local events with confidence attendees can actually 
attend, recruiters know where candidates actually live versus where employers are headquartered, and inside 
sales teams call during accurate time zones. Available now to all ZoomInfo customers. 
 
Use Case Tags: Account Prioritization, Prospecting, Audience Development, Ad Campaign Execution & ABM, 
Lead Management 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Demand Generation Managers 

 
 
1.8 Million New International Mobile Numbers 
 
Reach European prospects the same way you reach US prospects—with phone calls and texts, not just 
emails. Access mobile numbers for 1.8 million more international contacts, concentrated across six markets 
where customers told us coverage was blocking their expansion: UK (0.5 million), France (0.2 million), 
Germany, Italy, Spain, and the Netherlands. Mobile numbers automatically populate in Salesforce and 
HubSpot at no additional cost for all customers with mobile phone access. 
  
Use Case Tags: Data Management, Prospecting, Account Insights 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Revenue Operations 
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Applications 
GTM Workspace 
 
Combine and Customize Views with Manual Row Control 
 
Add specific companies or contacts to your ZoomInfo Views even when they don't match your filter criteria. 
This solves a common workflow problem: AEs managing 50 territory accounts who need to track 10 strategic 
Enterprise prospects in the same View, or SDRs building call lists that combine inbound leads with their own 
prospecting research. RevOps and Marketing Ops teams can build these hybrid Views on behalf of their reps, 
ensuring everyone has the right accounts in their workspace for outreach, campaign targeting, and play 
execution. 
Previously, maintaining these hybrid lists meant managing separate spreadsheets. Now search for any 
ZoomInfo company or contact and add it directly to your View. The system marks manually-added rows so 
you can distinguish them from filter-based results, and all accounts in your View—both filtered and manually 
added—become available for activation across GTM Workspace campaigns and plays. Added rows currently 
appear at the top and sort separately from filtered data (full merge sorting coming in a future update). 
 
Use Case Tags: Account Prioritization, Prospecting, Territory Design and Segmentation, Data Management 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Marketing Operations, Revenue 
Operations 
  

 
 

 
 Mobile Phone Access and Contact Masking in Views 
 
Build and refine contact lists in Views before exporting for outreach. Email addresses and phone numbers 
automatically mask when you add ZoomInfo contacts to Views, letting you explore which contacts exist at 
target accounts and decide which ones to export. Mobile phone numbers are now available alongside direct 
dials, giving you more ways to reach decision-makers. Available now in GTM Workspace Contact Views. 
  
Use Case Tags: Prospecting, Data Management 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Revenue Operations 
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Priority Fields: Quick Filters in Views 
 
When you open the filter menu in Views, priority fields now appear at the top based on which object type 
you're working with. For ZoomInfo Company Views, you'll immediately see HQ Country, Industry, Revenue 
Range, and Employee Count—the filters most practical for refining company lists. For Salesforce Views, the 
system surfaces the fields your admin designated as most important (pulled from your Salesforce compact 
layouts), so you see Close Date and Amount for Opportunities, or different fields for Accounts based on your 
team's setup. This eliminates scrolling through 100+ fields to find the ones you use most often. If you need a 
field outside the priority list, click "Show all fields" to access your complete field list. 
  
Use Case Tags: Account Prioritization, Deal and Pipeline Intelligence, Account Research and Meeting Prep, 
Prospecting 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Revenue Operations 
 

 
  

 
Discover What's Possible With One-Click GTM Workspace Actions 
 
Five quick-action buttons on your GTM Workspace homepage launch common high-value workflows 
instantly. This improves the new user experience by improving discoverability and eliminating the need for 
complex prompting. Click "Next Best Action" to get 3 AI-recommended actions for any account—like "Reach 
out to the new CFO who joined from a customer account"—based on CRM data, conversations, signals, and 
opportunities analyzed in seconds. Click "View" to build lists of closing opportunities or stalled accounts, 
"Meeting Prep" for instant call preparation, "Email" to generate personalized emails, or "Buyer Engagement" to 
map decision-makers. Available now on your GTM Workspace homepage. 
  
Use Case Tags: Account Insights, Prospecting, Deal Management, Account Prioritization, Playbook Design 
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Primary Personas: Account Executives / Account Managers, SDRs / BDRs 
  

 
Export to Outreach - GTM Workspace 
 
Build targeted contact lists in GTM Workspace Views (filter by industry, title, buying signals, territory), select 
your prospects, and add them to Outreach sequences in under 3 minutes—bulk operations that previously 
required 30-60 minutes of CSV exports, field mapping, and manual imports now complete with a few clicks. 
Single contact exports drop from 5-10 minutes of copying data between tools to 30 seconds. Available now 
for all GTM Workspace customers with Outreach connected in admin settings. 
  
Use Case Tags: Prospecting, Territory Design and Segmentation, Lead Management, Account Prioritization, 
Audience Development 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Revenue Operations 
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GTM Studio 
 
Signal-Based Workbook Creation 
 
Transform your targeting strategy by building prospect lists directly from comprehensive buying signals 
including website visits, job changes, funding events, and company intelligence. Operations teams can now 
start with signal-first targeting instead of only demographic lists, enabling systematic campaign workflows 
that capture prospects at optimal engagement moments. Available in GTM Studio workbook creation across 
all packages. 
  
Use Case Tags: Campaign Building & Targeting, Lead Generation & Qualification, Account Intelligence & 
Research, Sales Process Optimization, Marketing Campaign Management, GTM Strategy & Planning 
Primary Personas: Sales Operations, Revenue Operations, Marketing Operations 
 
 

 
 
Expanded Signal Enrichment 
 
Time your outreach with four new signals: Websights Buyer ID, Employment Changes, Funding, and 
Technologies Added/Dropped. Track website visitors from your buying groups, monitor when contacts join or 
leave companies, identify funding events, and see when prospects adopt or remove any technologies. For 
example, reach out when a contact you've engaged moves to a new company, when a prospect gets Series B 
funding, or when they add complementary software to their tech stack. These signals eliminate the manual 
research across multiple platforms that slows down your team, letting you focus on strategy instead of data 
hunting. Access them now through your workbook enrichment options. 
  
Use Case Tags: Data Management, Account Insights, Prospecting, Account Prioritization 
Primary Personas: Sales Operations, Revenue Operations, Marketing Operations 
  
 

 
 
Enrich Audiences with Job Posting data 
 
Stop manually researching hiring trends across multiple job sites - add daily-updated job posting counts 
directly to your company audiences for instant growth insights. Filter by department, geography, seniority, 
and keywords to identify prospects at the right moment: companies posting 20+ engineering roles signal 
major product development (prime time for development tools), businesses hiring AI specialists indicate AI 
investment (perfect for AI software), or organizations scaling sales teams show growth phase (ideal for any 
B2B solution). Use these counts to prioritize accounts and customize messaging around their specific 
expansion areas. Available now in GTM Studio Audiences - select 'Enrich' and choose Job Posting data. 
  
Use Case Tags: Prospecting, Account Insights, Account Prioritization 
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Primary Personas: Account Executives / Account Managers, SDRs / BDRs 
  

 
 
Audience List Activation to GTM Workspace 
 
RevOps can now send target prospect lists with AI-written emails directly to sellers' GTM Workspace, where 
they appear as ready-to-work views with complete account intelligence and pre-assigned ownership. When 
RevOps identify qualified accounts in GTM Studio using buying signals, intent data, and firmographic filters, 
they can publish these lists to specific sellers in three clicks - the prospects appear in GTM Workspace with 
personalized email drafts that reference company-specific context from ZoomInfo's proprietary dataset. 
Sellers open their workspace, see their assigned prospects with complete background, and send contextual 
emails in minutes instead of spending hours researching accounts and drafting outreach from scratch. 
  
Use Case Tags: Outbound Prospecting, Sales Enablement, Territory Management, Account Intelligence, Lead 
Routing, Sales Productivity, Email Personalization, New Business Development, Account-Based Sales, Sales 
and Marketing Alignment 
Primary Personas: Sales Operations, Revenue Operations, Demand Generation Managers 
 

 
 
Filter AI Credits Dashboard by User and Action Type 
 
Understand which AI enrichment actions deliver the most value across your team with new filtering in the AI 
Credits Dashboard. Filter credit usage by individual users or specific AI actions (web research, semantic 
enrichment, email generation) to see complete activity histories—every enrichment operation, credits 
invested, and dates. When planning how to empower teams with AI capabilities, identify which actions drive 
the best outcomes and ensure high-performing team members have credits allocated for strategic work. 
Available in the Admin Portal/GTM Studio for administrators. 
  
Use Case Tags: Administration & Setup 
Primary Personas: Revenue Operations, Marketing Operations 
  

 

  
 

​
Product Release Notes   ​ ​ ​ ​ ​ ​ ​ ​       ​ ​ 61 



 

 
ZoomInfo Copilot 
 
Admin-Defined Territory Assignment 
 
Sales administrators can eliminate prospect overlap and wasted selling time by defining territories once using 
company attributes (industry, location, size) with automatic round-robin account distribution that ensures 
each qualified prospect reaches exactly one salesperson. As your team expanded or restructured territories 
previously, overlapping assignments meant multiple reps contacted the same prospects, damaging 
relationships and wasting hours on duplicate research and outreach. In Copilot, administrators define 
territories and assign users in Settings > Targeting > Territories, so prospects matching those criteria appear 
in each rep's Whitespace feed within 24 hours through round-robin rotation—no individual rep configuration 
needed. 
  
Use Case Tags: Territory Design and Segmentation, Account Prioritization, Data Management 
Primary Personas: Revenue Operations, Sales Operations 
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Chorus Automated Moments API 
 
For customers with development resources: automatically capture and organize conversation insights using 
the new Chorus Automated Moments API. Define keywords for competitors, objections, or compliance topics, 
and Chorus creates timestamped call highlights and organizes them into curated playlists—eliminating the 
manual work of listening to entire calls and clipping moments for coaching and compliance documentation. 
This transforms Chorus into an active integration platform that feeds conversation intelligence directly into 
your business workflows. Available now in Chorus API documentation for customers with existing API access. 
  
Use Case Tags: Deal Management, Playbook Design, Account Insights 
Primary Personas: Sales Operations, Revenue Operations 
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Marketing 
 
WebSights AI Page Rank 
 
WebSights AI Page Rank automatically classifies your website pages by visitor intent (High, Medium, or Low) 
as traffic occurs, providing comprehensive rankings across sites with thousands of pages that would be 
impossible to manage with manual rules. More visitors get classified with actionable visitor intent signals, so 
filtering by High, Medium, or Low Visitor Intent surfaces companies exploring your full range of 
content—product features, solution pages, pricing, and technical resources—not just the handful of pages 
covered by manual rules. This enhanced visitor classification automatically improves In Market Score 
calculations and Copilot's Key Website Visitor Signal. Admins enable AI Page Rank in Admin Portal → Domains 
→ Page Rank for paid WebSights customers, with manual overrides available for any page. Available for all 
packages that include the paid version of WebSights (WebSights Lite excluded). 
  
Use Case Tags: Account Insights, Prospecting, Account Prioritization, Audience Development 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Demand Generation Managers 
  

 
 
WebSights Automated Traffic Visibility 
 
WebSights now provides more comprehensive identification of all website visitors with separate Company 
Traffic and Automated Traffic metrics in your Analytics Dashboard. This helps sales teams focus on genuine 
prospects instead of chasing sophisticated automated traffic from legitimate companies that creates false 
engagement signals. You gain clear visibility into real buying interest while seeing your total traffic 
identification strength through both metrics combined. The new Analytics Dashboard metrics automatically 
appear during the November rollout. Available for all packages that include WebSights visitor identification. 
  
Use Case Tags: Prospecting, Account Insights, Ad Campaign Execution & ABM, Data Management 
Primary Personas: Account Executives / Account Managers, SDRs / BDRs, Demand Generation Managers​
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Ecosystem & Admin 
 
Breached Credential Protection 
 
ZoomInfo now automatically monitors for compromised credentials and alerts you immediately if your 
password is exposed in a public data breach, protecting your account from unauthorized access. If your 
credentials are compromised, you'll receive an alert with a direct link to reset your password and secure your 
account—no action needed unless a breach is detected. This protection is available with username/password 
authentication, but not SSO. 
  
Use Case Tags: Data Management (security and compliance aspects) 
Primary Personas: Revenue Operations 
  

 
 
Data Sharing Page Updates 
 
Control exactly what data your connected apps share back to ZoomInfo with a redesigned Data Sharing page 
that replaces the prior interface with transparent controls and clear value explanations. Admins can now see 
at a glance whether sharing is active for email verification, website visitor identification, contact data 
enrichment, and benchmarking intelligence - with "Benefits and Impact" descriptions (like "reduces bounce 
rates and improves outreach accuracy" for email verification) before making any changes. Available in Admin 
Portal / GTM Studio > Privacy & Security > Data Sharing for admin users. 
  
Use Case Tags: Data Management, Administration & Setup 
Primary Personas: Revenue Operations, Marketing Operations 
 

 
 
Enhanced Performance Dashboard 
 
Stop manually compiling RingLead metrics. Access comprehensive dashboard metrics including duplicates 
removed, records enriched, prevention activity, data normalization, and routing performance - now with 
additional metrics we didn't track before and improved accuracy across all calculations. Customize your 
dashboard by adding, removing, or rearranging widgets to focus on what matters for renewals and QBRs, then 
export to PDF for stakeholder presentations. Available now in Analyze > Performance Dashboard (tracks from 
November 1, 2025 forward; access historical data via legacy dashboard link). 
 
Use Case Tags: Data Management, Administration & Setup  
Primary Personas: Revenue Operations, Sales Operations, Marketing Operations 
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Oct 21, 2025 ZoomInfo Release 
Highlights 

Data 

3.2M Personal Email Coverage Expansion 

Enhanced Title Classification with ML 

Comprehensive Person Briefs: Rich Professional Intelligence for Every Business Contact 

Enhanced Industry Classification for Pilot Customers 

1.9 Million Company Database Expansion 

Ecosystem & Admin 

Proactive Credit and Vendor Monitoring 

Applications 

Copilot 

Chorus/Google Meet Native Integration 

Google Meet Meeting Import for ZI Copilot 

Marketing 

Document & Voice Intent Topic Recommendations 

Multiple Account Fit Score Profiles 
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Data 
 
3.2M Personal Email Coverage Expansion 
 
Connect 3.2 million personal emails to business profiles for marketing, sales, and recruiting teams—when 
prospects visit your website or fill out forms with Gmail or Yahoo addresses, ZoomInfo reveals their 
professional identity, company, and business contact information. Enhanced matching automatically appears 
in website visitor identification, searches, ListMatch results, and Enrich operations. 
 
The 3.2 million personal email expansion is available now for: 

-​ Sales: Customers with Advanced+ or Elite+ packages and supplemental email SKU 
-​ Copilot: Customers with Advanced+ or Elite+ (via SalesOS) and supplemental email SKU 
-​ Talent: All users automatically 
-​ Marketing: Advertising Advanced+ users 

 
Use Case Tags: Account Insights, Data Management, Prospecting, Audience Development  
Primary Personas: Sales Development Representatives (SDRs), Account Executives (AEs) 
 

 
 
Enhanced Title Classification with ML 
 
Target professionals by department globally — 9.3M contacts now properly organized including 4.8M 
Operations, 1.0M Medical & Health, and 0.9M Engineering specialists. Previously, these professionals weren't 
showing up in department-filtered searches. Now access 7.4M international contacts across European 
markets (1.3M including France, UK, Germany, Netherlands), Brazil (1.0M), and India (0.4M), plus 1.9M US 
professionals in Advanced Search, DaaS data cubes, and API deliveries. 
 
Use Case Tags: Prospecting, Audience Development, Data Management 
Primary Personas: Sales Development Representatives (SDRs), Demand Generation Managers, Marketing 
Operations, Account Executives (AEs) 
 

 
 
Comprehensive Person Briefs: Rich Professional Intelligence for Every Business Contact 
 
Access detailed professional profiles including career progression, educational background, expertise areas, 
and achievements for any business contact to create personalized outreach based on actual professional 
context—for instance, reference a prospect's recent promotion to VP of Operations or their expertise in 
supply chain automation.  
 
Comprehensive Person Briefs automatically appear in Account AI's Important Contacts and C-suite sections 
and power Copilot Chat through embedded account summaries, meaning every Copilot Chat interaction 
leverages this enhanced professional intelligence for all Copilot Enterprise customers with no additional cost 
or setup required. 
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Use Case Tags: Account Insights, Prospecting, Account Prioritization, Audience Development 
Primary Personas: Account Executives (AEs), Sales Development Representatives (SDRs), Marketing 
Operations 
 

 
 
Enhanced Industry Classification for Pilot Customers 
 
Target more relevant prospects with improved industry classification accuracy across ZI Industry, SIC, and 
NAICS codes. Our updated modeling delivers better alignment between headquarters and location 
classifications, enabling more precise vertical-specific marketing and sales approaches. Pilot customers 
receive enhanced industry data through bespoke file delivery for feedback and validation. 
 
Use Case Tags: Data Management, Account Prioritization, Audience Development, Total Addressable Market 
(TAM) 
Primary Personas: Marketing Operations, Demand Generation Managers, Revenue Operations (RevOps) 

 
 
1.9 Million Company Database Expansion 
 
Access 1.9M new company records including prospects from your past searches that weren't previously 
available, plus 500K international companies across LATAM and EMEA for global expansion. This 
customer-driven expansion eliminates dead-end searches for companies you know exist, with 950K Tier A 
companies ready for immediate prospecting. The enhanced database automatically improves all ZoomInfo 
workflows including search, list building, and audience development. 
 
Use Case Tags: Total Addressable Market (TAM), Data Management, Prospecting, Audience Development 
Primary Personas: Sales Development Representatives (SDRs), Revenue Operations (RevOps), Marketing 
Operations, Demand Generation Managers 
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Ecosystem & Admin 
 
Proactive Credit and Vendor Monitoring 
 
Monitor credit usage and vendor health with automated email alerts for data enrichment operations. Set 
custom credit thresholds to receive alerts before depletion, plus get immediate notifications when vendor 
APIs fail due to authentication errors, access issues, or other problems. Configure alerts in RingLead 
Notification Settings to prevent enrichment tasks from failing silently, marketing campaigns from running on 
incomplete data, and sales teams from working with stale information. 
 
Use Case Tags: Data Management, Administration & Setup 
Primary Personas: Revenue Operations (RevOps), Marketing Operations, Sales Operations 
 
Related Knowledge Center Articles: 

●​ How to Set Up Proactive Credit and Vendor Monitoring in RingLead 
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Applications 
 

Copilot 

 
 
Chorus/Google Meet Native Integration 
 
Record Google Meet calls without bots joining your meetings. When Google updates their interface, your 
recordings keep working instead of breaking until we deploy fixes. Access this bot-free option in Settings > 
Integrations > Conference Admin Settings. 
 
Use Case Tags: Administration & Setup, Account Insights​
Primary Personas: Revenue Operations (RevOps), Sales Managers 
 
Related Knowledge Center Articles: 

●​ How to Set Up Meeting Import with Chorus 
 

 
 
Google Meet Meeting Import for ZI Copilot 
 
When you're preparing for your next prospect call, ZI Copilot now remembers insights from your previous 
Google Meet conversations - like noting the prospect mentioned their Q2 budget timeline, asked about 
specific integration requirements, or expressed concerns about their current vendor. This adds conversation 
intelligence to Copilot's unified GTM data platform, eliminating the intelligence gap that was limiting account 
recommendations when your most valuable sales data wasn't factoring into AI-powered insights.  
 
Your Google Workspace admin enables this through Copilot's meeting imports page with organizational 
controls for data governance, after which Google Meet recordings automatically enhance your account 
intelligence within 30 minutes to 3 hours (typical 30-minute calls process under an hour). 
 
Use Case Tags: Account Insights, Prospecting​
Primary Personas: Account Executives (AEs), Sales Development Representatives (SDRs), Revenue 
Operations (RevOps) 
 
Related Knowledge Center Articles: 

●​ How to Enable Meeting Import with ZoomInfo Copilot 
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Marketing 

 
 
Document & Voice Intent Topic Recommendations 
 
Start monitoring intent signals immediately by uploading your sales deck or describing what you sell—no 
60-90 day wait for CRM data. RevOps and Marketing teams get 5-15 AI-generated topic recommendations in 
2 minutes for new products, market expansions, or initial deployments, enabling same-day intent strategy 
deployment. This extends proven Intent AI capabilities to scenarios where historical opportunity data doesn't 
exist yet. Available now in Admin Portal > Intent > Recommendations. 
 
Use Case Tags: Data Management, Account Prioritization, Audience Development, Prospecting, Lead 
Management, Account Insights 
Primary Personas: Marketing Operations, Sales Operations, Demand Generation Managers, CMO/VP of 
Marketing, Revenue Operations (RevOps) 
 
Related Knowledge Center Articles: 

●​ How to Set Up Intent as an Admin with ZoomInfo 
 
 

 
 
Multiple Account Fit Score Profiles 
 
Build separate Account Fit Scores for each of your products in ZoomInfo Marketing—designed for 
multi-product organizations where mid-market and enterprise companies get maximum benefit. Marketing 
Operations creates product-specific scoring models once, then both marketing and sales teams use the right 
profile for their work.  
 
Navigate to Intelligence → Account Fit Score to create up to 5 distinct profiles (ABM Enterprise) or 3 profiles 
(ABM Lite), each trained on your actual customers for that specific product. When building campaign 
audiences or reviewing account recommendations, select which product profile to use—your CRM profile 
targets accounts that look like CRM buyers for both marketing campaigns and sales outreach, not your 
analytics product buyers. 
 
Use Case Tags: Account Prioritization, Audience Development, Data Management, Territory Design and 
Segmentation, Ad Campaign Execution & ABM 
Primary Personas: Marketing Operations, ABM Managers, Demand Generation Managers, Revenue Operations 
(RevOps) 
 
Related Knowledge Center Articles: 

●​ Account Fit Score (AFS) Explained 
●​ How to Configure Account Fit Score in the Admin Portal 
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Sept 16, 2025 ZoomInfo Release 
Highlights 

Data 

Discover 6 Million European Contacts with ML-Enhanced Department Classification 

Improved Contact Data Deduplication Consolidation 

Ecosystem & Admin 

WebSights Management in Admin Portal 

Automated Traffic Visibility in WebSights Beta 

Exclusion Filters: Admin-Controlled Data Filtering 

Custom Field Support for GTM Data Model 

Applications 

Copilot 

Chorus Mobile App: Record On the Go 

Navigation Simplification (ZoomInfo Sales, Copilot, and Marketing) 

Marketing 

Prioritize Package for HubSpot 

Redesigned Campaign Forecasting with Data-Driven Budget Recommendations 

MS Dynamics CRM Integration for Audience Building 

Partial Search in Account Overlay 

Account Fit Score Date Filtering 

GTM Studio 

CRM Advanced Query Logic (OR & Exclusions) 

Custom CRM Field Integration for Workbooks 

CRM Lookup Object Enrichment 

Owner Manager Hierarchy Filtering 

Snowflake Import Into Workbooks 

Column Templates (Now GA) 
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Data 
 
Discover 6 Million European Contacts with ML-Enhanced Department Classification 
 
Target specific business functions across European markets with 6 million newly discoverable contacts across 
ten key departments, led by Operations (4.7 million), Medical & Health (1.4 million), and Sales (731,000 
contacts). Our new and improved AI and machine learning models analyzed 5,000 of the most common 
previously unclassified European job titles, enabling international teams to eliminate the manual research that 
consumed prospecting time—for instance, find German Operations Directors for supply chain expansion or 
UK Marketing Managers for regional campaigns. Enhanced classification automatically appears in Advanced 
Search department filters, DaaS data cubes, and API deliveries with no setup required. 
 
Use Case Tags: Data Management, Prospecting, Account Insights, Audience Development, Total Addressable 
Market (TAM) 
Primary Personas: Sales Development Representatives, Demand Generation Managers, RevOps 

 
 
Improved Contact Data Deduplication Consolidation 
 
Enhanced contact record deduplication now provides more accurate profile merging using advanced ML 
detection. This backend improvement helps ensure related contact information appears together in 
comprehensive profiles during your normal ZoomInfo searches. 
 
Use Case Tags: Data Management 
Primary Personas: All ZoomInfo users (automatic benefit) 
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Ecosystem & Admin 
 
WebSights Management in Admin Portal 
 
WebSights setup is now streamlined in the Admin Portal with an improved experience that eliminates 
navigating between separate systems for implementation. Admin users can also enable WebSights, 
FormComplete, Chat, and Schedule from unified controls in a single interface, and admin-only users can 
complete full WebSights implementation independently without requiring additional access permissions. 
Available now in Admin Portal → Domains for all WebSights customers. 
 
Use Case Tags: Administration & Setup 
Primary Personas: RevOps 
 
Related Knowledge Center Article: 

●​ How to Use WebSights Page Rank in ZoomInfo Sales 
 

 
 
Automated Traffic Visibility in WebSights Beta 
 
WebSights now shows human visitor traffic separately from automated traffic, helping sales teams focus on 
genuine prospects instead of wasting time on false engagement signals. As sophisticated automated traffic 
from legitimate companies increasingly generates visits that appear to be from potential prospects but are 
actually non-human traffic, this enhancement provides clear visibility into which visitors represent real buying 
interest. To participate in this opt-in beta program, contact your Customer Success Manager or Account 
Executive. 
 
Use Case Tags: Prospecting, Account Insights, Data Management 
Primary Personas: Sales Development Representatives, Account Executives, Demand Generation Managers, 
Digital Marketing Managers 
 

 
 
Exclusion Filters: Admin-Controlled Data Filtering 
 
See only relevant records in ZoomInfo search results by configuring admin-controlled exclusion filters that 
automatically remove unwanted data—like test accounts cluttering pipeline reports or inactive prospects that 
waste sales time—while preserving complete records for compliance and historical reporting. Previously, 
managing these exclusions required maintaining external CRM lists and reports that frequently broke and 
couldn't handle growing data volumes, leaving revenue teams to manually filter through irrelevant results. 
Available now for GTM Workbooks customers through the import mapping interface, with 24-hour processing 
that applies your rules to both existing and future records across accounts, contacts, and opportunities. 
 
Use Case Tags: Administration & Setup, Data Management 
Primary Personas: RevOps 
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Related Knowledge Center Article: 
●​ How to Set Up Import Rules in GTM Studio 

 
 

 
 
Custom Field Support for GTM Data Model 
 
Sync your CRM's custom fields directly into ZoomInfo, so business-specific data like "Account Tier: Gold, 
Silver, Bronze" or "Account Manager: Sarah Johnson" appears in your workbooks for filtering and enrichment. 
Previously, CRM fields that didn't match ZoomInfo's standard data model were unavailable within your 
ZoomInfo workflows, forcing teams to toggle between systems for complete account context. Revenue 
Operations teams can set up custom fields in the Admin Portal's GTM Objects section, then map them during 
CRM import to make your complete CRM data available across ZoomInfo's platform. 
 
Use Case Tags: Data Management, Account Prioritization, Prospecting 
Primary Personas: RevOps, Marketing Operations 
 
Related Knowledge Center Article: 

●​ How to Create Custom Fields for GTM Objects in GTM Studio 
 
 

Applications 
 

Copilot 

​
 
Chorus Mobile App: Record On the Go 
 
Capture conversational intelligence from any interaction using one-tap mobile recording that transforms 
impromptu meetings, facility drops, and cold calls into full Chorus analysis within 30 minutes. Field sales reps 
previously lost valuable customer conversations that happened during unscheduled territory visits, while 
inside reps missed coaching opportunities from cold calling insights. Open the Chorus mobile app, tap record, 
and get the same transcription, sentiment analysis, and coaching insights as scheduled meetings. 
 
Use Case Tags: Prospecting, Deal Management, Account Insights 
Primary Personas: Field Sales Reps, SDRs, Account Executives/Account Managers 
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Navigation Simplification (ZoomInfo Sales, Copilot, and Marketing)​
 
Access ZoomInfo tools instantly with the new collapsible left-hand navigation that groups key features 
logically, letting sales teams find insights and take actions in fewer clicks without digging through cluttered 
menus. The previous navigation was slowing teams down with scattered tool locations that created friction 
and pulled focus away from selling activities. Try the redesigned navigation today across ZoomInfo Sales, 
Copilot, and Marketing —customize your workspace by collapsing or expanding the menu to stay focused 
and productive.​
 
Use Case Tags: Data Management, Prospecting, Account Insights, Ad Campaign Execution & ABM​
Primary Personas: SDRs, Account Executives, Digital Marketing Managers, Marketing Operations 
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Marketing 

 
 
Prioritize Package for HubSpot 
 
See which HubSpot accounts are moving through your funnel with Account Fit Score (showing high-fit 
prospects based on your closed-won patterns), In-Market Score (0-100 scale indicating Target, Awareness, 
Interest, Consideration, or Evaluation stage), and WebSights visitor identification showing which companies 
visited your pricing pages or product demos. This eliminates manual weekly spreadsheet exports where teams 
previously managed account prioritization outside HubSpot, preventing automated marketing sequences 
based on buying signals. Available now through ZoomInfo Admin Portal with nightly automated sync, 
pre-configured field mappings for all data points, and no additional credit charges for ZoomInfo Marketing 
customers with HubSpot CRM integration. 
 
Use Case Tags: Account Prioritization, Audience Development, Lead Management, Account Insights, Data 
Management 
Primary Personas: Marketing Operations, Demand Generation Managers, RevOps 
 
Related Knowledge Center Article: 

●​ How to Enable the Prioritize Dashboard Sync in the Admin Portal 
 

 
 
Redesigned Campaign Forecasting with Data-Driven Budget Recommendations 
 
You can now set campaign budgets with confidence using minimum spend recommendations based on 
historical performance data. For example: 

●​ When you target a set of accounts (e.g., 500 accounts), the system calculates and displays the 
minimum budget required to reach engagement thresholds that drive account responses.  

●​ If you enter a budget below the minimum, you'll see a clear warning that your spend won't generate 
meaningful impact.  

●​ If your budget meets or exceeds the recommended level, you'll see a green confirmation that your 
campaign is properly configured. 

 
This update helps teams configure campaigns more efficiently and independently, relying on data-driven 
guidance rather than manual budget guesswork. Available now in the campaign forecasting interface for all 
DSP advertising customers. 
 
Use Case Tags: Ad Campaign Execution & ABM, Data Management  
Primary Personas: Marketing Operations, Demand Generation Managers  
 
Related Knowledge Center Article: 

●​ How to Streamline Advertising Efforts with ZoomInfo Marketing Campaign Delivery Forecasting 
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MS Dynamics CRM Integration for Audience Building 
 
Build marketing audiences using your MS Dynamics data to target accounts based on your actual sales 
activity. Filter by "Opportunity Stage" to create retargeting audiences for deals stuck in proposal phase, or use 
"Account Owner" filters to build territory-specific campaigns that align with your sales rep assignments. 
  
Connect through Admin Portal > Integrations first, then find Dynamics filters in ZoomInfo Marketing's 
audience builder under "Show Filters" > "Dynamics" to combine CRM data with ZoomInfo's targeting 
capabilities. 
 
Use Case Tags: Audience Development, Ad Campaign Execution & ABM, Account Insights, Data Management, 
Territory Design and Segmentation 
Primary Personas: RevOps, Marketing Operations, Demand Generation Managers 
 

 
 
Partial Search in Account Overlay 
 
Find the right account instantly when searching partial names like "Google" - see all matching accounts 
(Google Fiber, Google Review, Google AI) with company metrics to identify your target without guesswork. 
Previously, you had to click through multiple similar account names using trial and error to find the correct 
one. Apply filters like "ad spend > $100" to find specific accounts running campaigns. This feature is available 
in ZI Marketing on the Accounts Page, in the Account Overlay in the Unified Funnel Dashboard, and in the 
Campaign Dashboard. 
 
Use Case Tags: Account Insights, Data Management 
Primary Personas: Marketing Operations, Digital Marketing Managers, Demand Generation Managers 
 

 
 
Account Fit Score Date Filtering 
 
Focus your account scoring on recent customer representation instead of outdated historical data. If your 
business has pivoted, operates seasonally, or your ideal customer profile has evolved, the new date filtering 
feature directly solves this challenge by allowing you to train your Account Fit Score using only relevant time 
periods. This targeted approach ensures your scoring reflects your most current customer base - like the last 
6 months since your product pivot, or just your peak season customer data. 
 
The date filter eliminates the noise of irrelevant historical data by letting you choose from recent timeframes 
(last 1, 3, 6, or 12 months), specific dates (after your pivot date), or custom ranges (holiday season buyers 
only). This precision targeting means your Account Fit Score accurately represents who your customers are 
today, not who they were years ago. Find this powerful filtering option in Admin Portal under Account Fit 
Score settings for CRM-connected configurations. 
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Use Case Tags: Account Prioritization, Data Management 
Primary Personas: RevOps, Sales Operations 
 
Related Knowledge Center Article: 

●​ Account Fit Score Explained 
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GTM Studio 

 
 
CRM Advanced Query Logic (OR & Exclusions) 
 
Build complex account queries using OR logic and exclusions just like your CRM reports. Previously, RevOps 
teams were limited to basic AND-only filter logic when working with CRM data in workbooks, forcing them to 
create multiple separate queries for scenarios like "Type is Customer OR Type is Prospect without Open 
Opportunities." Available in Customer Early Access for GTM Studio Workbook customers starting September 
2025. 
 
Use Case Tags: Data Management, Account Prioritization 
Primary Personas: RevOps Specialists, Sales Operations 
 

 
 
Custom CRM Field Integration for Workbooks 
 
Filter and analyze accounts using your custom CRM data directly in GTM Studio workbooks without CSV 
exports. RevOps teams can now create custom GTM Data Model fields, map them to CRM fields like 
subscription types or industry attributes, and use this business-specific data for dynamic workbook filtering 
and analysis. Available in Customer Early Access for GTM Studio + Workbooks customers starting September 
2025. 
 
Use Case Tags: Data Management, Account Prioritization, Territory Design and Segmentation 
Primary Personas: RevOps Specialists, Marketing Operations 
 

 
 
CRM Lookup Object Enrichment 
 
See actual owner names and details instead of cryptic lookup IDs when enriching workbooks with CRM data. 
Previously, importing CRM accounts showed meaningless identifiers like "Owner ID: ABC123," making it 
impossible to filter by actual owner names or organize workspaces effectively. Available in Customer Early 
Access for all Workbook customers with CRM integration starting September 2025. 
 
Use Case Tags: Data Management, Territory Design and Segmentation 
Primary Personas: Sales Managers, RevOps Specialists 
 

 
 
Owner Manager Hierarchy Filtering 
 
Filter by your manager name to automatically capture all team accounts across your complete reporting 
hierarchy. Sales Managers previously had to manually select each individual team member when creating 
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portfolio workbooks, creating time-consuming workflows and risk of missing team members in complex 
organizational structures. Available in Customer Early Access for GTM Studio Workbook customers starting 
September 2025. 
 
Use Case Tags: Territory Design and Segmentation, Deal Management 
Primary Personas: Sales Managers 
 

 
 
Snowflake Import Into Workbooks 
 
Access your Snowflake data directly in workbooks instead of waiting for CSV exports from data teams. 
Marketing Ops, RevOps, and Sales Ops teams can now connect GTM Studio directly to their Snowflake 
warehouse, browse schemas, preview data, and build analytical workbooks immediately. Available in Customer 
Early Access for all GTM Studio customers starting September 2025. 
 
Use Case Tags: Data Management, Audience Development, Ad Campaign Execution & ABM 
Primary Personas: Marketing Operations, RevOps Specialists 
 

 
 
Column Templates (Now GA) 
 
GTM Studio helps our customers enrich, analyze and prioritize audiences for specific plays. The creativity and 
time that goes into building attributes is currently locked within a single Workbook. Once you spend the time 
building a valuable set of qualification criteria, you should be able to save those columns, re-use them, apply 
them to different audiences and share them amongst your team. Column templates allow you to do exactly 
that. Column templates will handle the input dependencies from other fields. Note: Column templates can 
only be added to Workbooks with the same source (e.g CSV, ZoomInfo, CRM).  
 
Use Case Tags: Data Management, Account Prioritization, Prospecting 
Primary Personas: RevOps, Marketing Operations 
 
Related Knowledge Center Article: 

●​ How to Use Column Templates in GTM Studio 
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Aug 19, 2025 ZoomInfo Release 
Highlights​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ Back to top 

Data 

Franchise Vertical Dataset 

Restaurant Vertical Dataset 

Enhanced Website Visitor Identification 

500,000 Additional Verified Business Emails 

Enhanced Mobile Coverage with 14.7 Million Numbers 

Ecosystem & Admin 

ZoomInfo Salesforce Native App Authentication Security Enhancement 

Salesforce Sync Analytics 

Applications 

Copilot 

Intent Topic AI Recommendation for GTM Teams 

See What Every Department Discussed With Your Accounts 

Microsoft Teams Meeting Import for ZoomInfo Copilot 

Mobile App: Location / Building Specific Company Search 

Marketing 

Download Account Fit Score Data in Seconds Instead of Days 

Campaign Performance Notifications 

GTM Studio 

Column Templates (Beta) 

Enhanced Sheet Details & Filter Visibility 

Enhanced Workbook Organization & Discovery 

Complex Filtering in Workbook for Precise Segmentation 

Real-Time Recommended Signals for All Workbook Accounts 

CRM Writeback Configuration Enhancements 

Streamlined CRM Workbook Creation 
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Data 
Franchise Vertical Dataset 
 
See the complete franchise ownership hierarchy - from corporate franchisors to multi-unit operators to 
individual owners - with verified contact info for key decision-makers across 3,000+ franchise brands and 
150,000+ locations. Discover which existing customers are owned by franchisors operating 10+ additional 
restaurants, enabling expansion from single deals to comprehensive portfolio relationships. Use this 
intelligence for territory planning, competitive analysis, and strategic account prioritization instead of 
manually researching franchise disclosure documents that become outdated annually and can't be mapped 
with contact data. Available now via GTM Studio, Snowflake, Google BigQuery, Amazon S3, or flat file delivery 
with quarterly updates. 
 
Use Case Tags: Account Prioritization, Prospecting, Territory Design and Segmentation, Up-Sell & Cross-Sell 
Identification, Data Management, Total Addressable Market (TAM), Audience Development 
Primary Personas: Account Executives, Account Managers, Revenue Operations, Sales Development 
Representatives, Marketing Operations 
 

 

 
Restaurant Vertical Dataset 
 
Access 1M restaurants with ownership intelligence, cuisine details, and liquor license status. Previously, 
restaurant targeting meant working with incomplete lists and generic industry codes that couldn't distinguish 
between corporate-owned stores, multi-unit franchisees, and independent owners—leading to misdirected 
outreach and missed opportunities. Now you can filter by operational attributes like "Full Service Italian with 
Liquor License" or "Limited Service Franchise" while accessing pre-enriched contact data that shows you 
exactly who owns each location. Available quarterly via GTM Studio, Snowflake, Google BigQuery, Amazon S3, 
or flat file delivery. 
 
Use Case Tags: Account Prioritization, Prospecting, Territory Design and Segmentation, Up-Sell & Cross-Sell 
Identification, Data Management, Total Addressable Market (TAM), Audience Development 
Primary Personas: Account Executives, Account Managers Revenue Operations, Sales Development 
Representatives, Marketing Operations 
 

 
 
Enhanced Website Visitor Identification 
 
Up to 10% increased website visitor company identification powered by 74 million new IP-to-domain pairs 
across 5 million companies. Your sales team can follow up with more prospects showing research interest and 
enabling your marketing team to generate more complete attribution data for campaigns. This delivers more 
qualified prospects in WebSights, additional Intent signals for finding in-market customers, and more 
effective advertising campaigns.  
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Use Case Tags:, Ad Campaign Execution & ABM, Audience Development, Prospecting​
Primary Personas: Sales Development Representatives, Account Executives, Marketing Operations, Demand 
Generation Managers 
 

 
 
500,000 Additional Verified Business Emails 
 
Access 500,000 more business email contacts across industries and company sizes globally - fewer bounces 
when building prospect lists, running email campaigns, and enriching CRM records. 
 
Use Case Tags: Data Management, Prospecting, Audience Development​
Primary Personas: Sales Development Representatives, Marketing Operations, Sales Operations 

 
 

 
Enhanced Mobile Coverage with 14.7 Million Numbers 
 
Access 14.7 million newly validated mobile phone numbers to reach decision-makers directly. The enhanced 
mobile data works within your existing ZoomInfo searches and CRM workflows, improving prospect 
connection rates by 23% and reducing time-to-contact by 67% through comprehensive US coverage (96%) 
and expanded international reach. 
 
Use Case Tags: Prospecting, Account Insights, Audience Development​
Primary Personas: Sales Development Representatives, Account Executives, Demand Generation Managers
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Ecosystem & Admin 
ZoomInfo Salesforce Native App Authentication Security Enhancement 
 
Control who can access your ZoomInfo authentication details in Salesforce by limiting visibility to only 
authorized users with proper permissions, meeting enterprise security requirements that prevent 
unauthorized access to sensitive credentials. Previously, any user in your Salesforce instance could view 
ZoomInfo authentication tokens, but now only users you specifically authorize can access them. This 
one-time configuration is required when upgrading to SFNA v1.50 and can be completed in your Salesforce 
setup with ZoomInfo support guidance. 
 
Use Case Tags: Administration & Setup 
Personas: Revenue Operations 
 

 
 
Salesforce Sync Analytics 
 
See exactly what's happening with your ZoomInfo data sync by monitoring record counts at each stage - if 
1,000 records matched in your CRM but only 800 synced, you'll know there's an API limit or sync issue to 
address. Create custom fields where your ZoomInfo data points flow into Salesforce, then generate reports 
and dashboards in one click to track sync performance and identify accounts for prioritization. Previously, 
marketing ops teams had to raise support tickets to understand sync problems and couldn't easily see where 
data flow issues occurred between ZoomInfo and Salesforce. Access diagnostic insights and field 
management in the admin portal under System > Integrations > Connections > Salesforce > Prioritize Sync 
tab (requires Prioritize Package in ZI Marketing and admin portal access). 
 
Use Case Tags: Data Management,​
Primary Personas: Marketing Operations, Revenue Operations 
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Applications 

Copilot 

 

Intent Topic AI Recommendation for GTM Teams 
 
See which intent topics actually drive opportunities in your CRM with AI that analyzes your opportunity data 
to recommend topics with proven conversion rates like "Companies researching zero trust architecture were 
[significantly] more likely to create opportunities." Marketing teams focus budget on content around topics 
that actually generate pipeline, while sales teams prioritize accounts showing research on your 
highest-converting topics - eliminating the manual analysis of 5,000+ intent topic options that previously 
wasted 30% of teams' time. Available now in ZoomInfo Admin Portal for Intent customers with CRM 
integration - initial recommendations appear within 24-48 hours of connecting Salesforce or HubSpot. 
 
Use Case Tags: Account Prioritization, Audience Development 
Primary Personas: Marketing Operations, Demand Generation Managers, Revenue Operations 

 

See What Every Department Discussed With Your Accounts 
 
Get instant context from any customer meeting across sales, support, product, and customer success 
teams—with AI summaries, searchable transcripts, and full video playback for Copilot Enterprise users. When 
researching Microsoft before your renewal meeting, you can instantly see that support discussed 
implementation challenges last week, review the AI summary highlighting key concerns, and watch the 
relevant clips to understand the customer's perspective.  
 
Use Case Tags: Account Insights, Prospecting, Account Prioritization​
Primary Personas: Account Executives, Account Managers, Customer Success Managers, Revenue 
Operations 

 

 
Microsoft Teams Meeting Import for ZoomInfo Copilot 
 
Automatically capture and analyze Microsoft Teams meetings with target accounts to ensure complete 
account intelligence across your customer interactions, enhancing account summaries and meeting 
preparation insights. Previously, Teams meetings weren't captured in your account intelligence system, 
creating gaps where critical customer conversations went unanalyzed. Revenue Operations can enable this 
organization-wide through a one-time admin setup in the meeting imports page. 
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Use Case Tags: Account Insights,​
Primary Personas: Account Executives, Account Managers, Revenue Operations 
 

 

 
Mobile App: Location / Building Specific Company Search 
 
See which companies are in each building before field visits and find prospects by typing specific street 
addresses directly in your mobile app. Previously, field reps wasted time navigating through 
country→state→city filter sequences and switching to separate mapping apps to understand where 
companies were located. Now tap the map icon next to any company headquarters to view all office locations 
as pins, see facility size and layout through satellite view to assess operational scale, then tap any pin to 
access the employee list at that specific location. Type any address, business district, or street name to find 
prospects with precision instead of broad city-level results. Saves field reps time on meeting prep and 
increases daily meeting density from 3 to 5 meetings per day through better territory coverage. Available 
immediately in your ZoomInfo mobile app. 
 
Use Case Tags: Account Insights, Prospecting, Territory Design and Segmentation 
Primary Personas: Field Sales Rep 
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Marketing 

 

Download Account Fit Score Data in Seconds Instead of Days 
 
Download Account Fit Score (AFS) data instantly from the main listing page through the new "Download 
Data" option in each row's Actions menu. Previously, customers waited 2-3 days for support teams to retrieve 
this data from backend systems - now you get it in seconds to validate the data powering your AFS 
recommendations. Access this through the three-dot Actions menu on any AFS row in your main listing page. 
 
Use Case Tags: Data Management, Administration & Setup​
Primary Personas: Sales Operations, Revenue Operations, Marketing Operations 
 

 

 
Campaign Performance Notifications 
 
ZoomInfo Marketing now helps you catch critical campaign issues before they impact performance through 
proactive monitoring alerts. When your campaign budget is exhausted, you get an immediate alert with a 
direct path to add more spend. Integration disconnected? Your admin receives notification within 24 hours 
with clear resolution steps. Campaign ending in 7 days? Direct link to extend it and maintain momentum. This 
systematic approach eliminates the manual monitoring overhead that pulls RevOps teams away from 
strategic work while ensuring no campaign goes dark due to missed alerts. 
 
The system activates automatically with zero configuration required, delivering notifications based on your 
active campaigns and integrations 
 
Use Case Tags: Ad Campaign Execution & ABM, Data Management, Administration & Setup 
Primary Personas: Marketing Operations 
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GTM Studio 

 

Column Templates (Beta) 
 
GTM Studio helps our customers enrich, analyze and prioritize audiences for specific plays. The creativity and 
time that goes into building attributes is currently locked within a single Workbook. Once you spend the time 
building a valuable set of qualification criteria, you should be able to save those columns, re-use them, apply 
them to different audiences and share them amongst your team. Column templates allow you to do exactly 
that. Column templates will handle the input dependencies from other fields. Note: Column templates can 
only be added to Workbooks with the same source (e.g CSV, ZoomInfo, CRM).  
 
Use Case Tags: Data Management, Account Prioritization, Prospecting 
Primary Personas: Revenue Operations, Marketing Operations 
 

​
​
Enhanced Sheet Details & Filter Visibility 
 
GTM Studio users are often creating multiple Workbooks and sharing Workbooks amongst their revenue 
teams. One of the first questions asked when opening a Workbook is “what was the criteria used to create this 
Workbook?” Previously, users had no visibility into what filters were applied. Click "Sheet Details" on any sheet 
to view the data source (ZoomInfo, CRM, or CSV), data type, row/column counts, refresh cadence, and all 
filters or criteria used during creation, ensuring data consistency and accelerating collaborative 
decision-making across revenue operations, marketing operations, and sales teams.  
 
For example, when a sales analyst receives a territory workbook from a colleague, they can access the Sheet 
Details to see the data came from Salesforce Opportunities with filters for 'Stage = Closed Won' and 'Amount 
> $50K'.  
 
Use Case Tags: Data Management, Account Insights 
Primary Personas: Revenue Operations, Marketing Operations, Data Analysts 
 

 
 
Enhanced Workbook Organization & Discovery 
 
Organize and find your workbooks faster with new filtering to accelerate your GTM operations. See which 
data sources (ZoomInfo, CRM, CSV) are used across all sheets in each workbook, then filter by creator, 
creation date, modification date, or specific data sources to quickly locate exactly what you need. For 
example, RevOps managers can now instantly see all workbooks using Salesforce data and filter to only those 
modified in the last 30 days, instead of opening each workbook individually to check.  
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Previously, finding relevant workbooks required manual searching through your entire list without knowing 
what data sources were being used, slowing down your ability to move fast on GTM initiatives. Find these 
features on your Workbooks landing page in GTM Studio. 
 
Use Case Tags: Data Management, Account Prioritization 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
 

 
 
Complex Filtering in Workbook for Precise Segmentation 
 
Build precise account and contact segments with new complex filtering within workbooks that supports 
multi-select options and logical combinations, enabling sophisticated GTM targeting across all revenue 
functions and accelerating coordinated execution from audience development through account prioritization. 
Create sophisticated filter combinations using AND/OR logic, like filtering for companies in "Technology" OR 
"Healthcare" industries AND with employee counts greater than 500 AND engagement scores above 75. 
RevOps teams can now build their workbook and then filter for accounts in multiple territories (West Coast 
OR East Coast) that have been contacted in the last 30 days AND have engagement scores above 75. The 
new visual filtering interface shows exactly how your criteria connect together and offers enhanced operators 
based on data types. Previously, users could only apply simple AND or simple OR logic between filters with 
single-value limitations, forcing broader datasets or manual workarounds for precise targeting. Access 
complex filtering within any workbook's filtering interface. 
 
Use Case Tags: Account Prioritization, Audience Development, Prospecting 
Primary Personas: Revenue Operations, Marketing Operations, Sales Operations 
 

 
 
Real-Time Recommended Signals for All Workbook Accounts 
 
Spot sales opportunities across your entire workbook with Recommended Signals like funding rounds, 
executive changes, and competitive research now generated in real-time for every account. Previously, these 
buying signals only appeared for Target and Whitespace accounts, limiting coverage of signals. Now access 
25+ signals including CXO changes, funding events, and technology adoption directly in the Enrich panel for 
any workbook account in GTM Studio. 
 
Use Case Tags: Account Prioritization, Prospecting, Account Insights 
Primary Personas: Account Executives, Revenue Operations, Sales Development Representatives 
 

 
​
CRM Writeback Configuration Enhancements 
 
Set up CRM writeback faster with configuration screens that show only your CRM's options - HubSpot 
administrators can configure calls and meetings separately using native "Meeting" records, while Salesforce 
users see only relevant Task and Account settings. Previously, administrators wasted time navigating complex 
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interfaces with irrelevant options for all CRM types, requiring extensive support calls that customers 
described as "drinking from a fire hose." Available now in GTM Studio’s CRM Writeback settings. 
 
Use Case Tags: Administration & Setup, Data Management​
Primary Personas: Revenue Operations, Marketing Operations 
 

 

Streamlined CRM Workbook Creation 

Building workbooks from your CRM data is now faster and more intuitive with a redesigned filtering 
experience. Create filters using keyboard shortcuts (arrow keys to navigate, tab between fields, enter to add), 
search instantly in dropdown menus without extra clicks, and see filters apply immediately without hunting for 
an "Apply" button. Available now in GTM Studio when creating CRM workbooks. 

Use Case Tags: Data Management, Audience Building, prospecting​
Primary Personas: RevOps, Marketing Operations, Sales Ops, Sales Manager 
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Jul 15, 2025 ZoomInfo Release 
Highlights​ ​ ​ ​ ​ ​ ​ ​ ​ ​ ​ Back to top 

Data 

Licensed Contractor Data Cube 

Expanded Company Coverage via Unmatched Domains: 220,000+ Companies Added to Database 

Enhanced Personal Contact Coverage 

Improved Email Compatibility for CRM Integration 

Ecosystem & Admin 

CRM Data Sync Frequency Enhancement for GTM Studio 

CRM Field Import Mapping in GTM Studio 

OAuth API Access via Developer Portal 

Data Passport Controls: Expanded Rule Capacity 

Microsoft Intune Support for Chorus Mobile App 

Applications 

Copilot 

Top Contacts 2.0 with AI-Powered Contact Recommendations 

Keyboard Shortcut for Chrome Extension 

Enhanced Copilot Chat with Advanced AI Capabilities 

Upcoming Meeting Plays 

Marketing 

Campaign Forecasting International & Video Expansion 

Zip Code + Radius Filter Update in ZI Marketing 

GTM Studio 

Data Agent Extended Prompt Capacity 

Saved Workbook Views 
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Data 
 
Licensed Contractor Data Cube  
 
Access licensed contractors who don't appear in standard B2B databases - including sole proprietors and 
small operations that operate without traditional digital footprints. The Licensed Contractor Data Cube pulls 
licensing records directly from government sources, combining verified licensing data with firmographic 
attributes to enable targeting by license classifications, expiration dates, and specialty endorsements. Your 
reps were missing qualified prospects because standard databases only capture businesses with digital 
presence - this dataset adds 2-3x more qualified prospects by reaching contractors regardless of their online 
footprint. Target contractors by specific license classifications and expiration dates to time outreach around 
renewals and identify newly licensed businesses entering your market.  
 
Use Case Tags: Territory Planning, Prospecting 
Primary Personas: Account Executives, Sales Development Representatives, Revenue Operations 

 

Expanded Company Coverage via Unmatched Domains: 220,000+ Companies Added to Database 

Find prospects that were previously missing from ZoomInfo searches with 220,000+ new Tier A company 
records now available in your database. These companies were identified from actual customer search 
patterns—when you searched for a company and got "no results found," we tracked those requests and 
systematically built profiles for the companies you needed most. This expansion eliminates dead-end 
prospecting sessions that previously forced you into manual research, giving SDRs more complete territory 
coverage, AEs better account intelligence, and Marketing teams accurate TAM analysis. All new companies 
are available immediately through your standard search process at no additional cost. 

Use Case Tags: Data Management, Prospecting, Account Prioritization, TAM, Territory Design and 
Segmentation​
Primary Personas:  Account Executives, Sales Development Representatives 

 

Enhanced Personal Contact Coverage 

Access 17.5M additional personal emails that turn anonymous website visitors into sales opportunities. When 
John from Acme Corp visits your website using his personal email, you can now see he's the VP of Sales at 
Acme and reach out directly. Matching on ListMatch, Enrich, and Advanced Sync just got better too—you'll 
get more contacts matched from your data. Sales and Copilot customers with the supplemental email SKU 
will see these enhanced contacts automatically in ZoomInfo searches, exports, and ListMatch results, while 
Talent users already have access to this expanded personal email coverage in their candidate searches and 
outreach workflows. 

Use Case Tags: Prospecting, Audience Development, Data Management​
Primary Personas: Account Executives, Sales Development Representatives, Demand Generation Managers 
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Improved Email Compatibility for CRM Integration 

We heard your feedback about CRM integration challenges and responded. Sync ZoomInfo contact data to 
your CRM systems without validation errors by automatically filtering out email addresses with special 
characters that cause integration failures. Previously, emails containing non-ASCII characters created sync 
conflicts and delivered successfully only 5% of the time, forcing manual workarounds and data cleanup. We've 
eliminated 1 million problematic email addresses from our database, ensuring your CRM integrations work 
smoothly and your email campaigns reach their intended recipients. This improvement is already active across 
all contact data without requiring any setup. 

Use Case Tags: Data Management, Prospecting, Ad Campaign Execution & ABM​
Primary Personas: Revenue Operations, Demand Generation Managers 
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Ecosystem & Admin 

CRM Data Sync Frequency Enhancement for GTM Studio 

Your CRM data now syncs every 6 hours instead of every 24 hours in GTM Studio, immediately solving data 
accuracy issues for workbook analysis. When you update account ownership in Salesforce on Monday 
morning - like reassigning Google to a new rep - your workbooks show the correct owner by Monday 
afternoon instead of Tuesday morning. Marketing teams running campaign attribution analysis will see lead 
status updates within hours instead of analyzing yesterday's data and making decisions on outdated 
information. This eliminates the confusion of seeing different account owners between your CRM and 
ZoomInfo, or running territory and performance analysis on stale data. Previously, teams had to manually 
request syncs or wait up to 24 hours to see critical changes reflected in their workbooks. The improvement 
activates automatically with no configuration required, with additional GTM Studio features connecting to 
this enhanced sync in upcoming releases. 

Use Case Tags: Data Management, Account Prioritization, Territory Design and Segmentation​
Primary Personas: Revenue Operations, Sales Operations, Marketing Operations, Account Executives 

 

CRM Field Import Mapping in GTM Studio 

Bring your custom CRM fields into ZoomInfo so your team can work with the data that matters to your 
business. Import Mapping lets you use your custom CRM fields like "Customer Type" to help your team quickly 
identify if accounts are current customers, prospects, or lost opportunities, or bring in your custom "Account 
Owner" field to surface your named accounts exactly as they're organized in your CRM.  

Previously, sales reps building target lists couldn't distinguish between account types using ZoomInfo's 
generic fields, forcing RevOps teams to spend hours manually cleaning data or creating workarounds for basic 
segmentation. This one-time setup in the GTM Studio Admin Portal ensures your team sees the CRM data 
that drives your business decisions across every ZoomInfo feature, replacing generic default fields with the 
information that matters to your sales process. Available initially for GTM Studio customers, with rollout to 
additional ZoomInfo customers planned for the near future. 

Use Case Tags: Data Management, Account Prioritization, Prospecting, Territory Design and Segmentation​
Primary Personas: Revenue Operations, Account Executives 

 

OAuth API Access via Developer Portal 

RevOps teams can now automatically sync ZoomInfo prospect data directly into Salesforce leads and 
marketing automation systems using the same SSO login their teams already use, eliminating the manual data 
entry and authentication barriers that previously blocked enterprise integrations. Partners who lost deals 
because customers couldn't approve applications without enterprise security compliance can now close those 
opportunities, while API access is included free with Copilot packages. Teams can set up these data 
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integrations in weeks instead of months through the new Developer Portal, enabling RevOps to maintain 
accurate territory assignments and account prioritization across their entire revenue tech stack. 
 
Use Case Tags: Data Management, Account Prioritization, Administration & Setup​
Primary Personas: Revenue Operations, Partners 

 

Data Passport Controls: Expanded Rule Capacity 

Configure up to 20 region-specific data access rules instead of 10, enabling sophisticated data governance 
strategies that power comprehensive GTM operations from account insights to audience development. 
Previously, the 10-rule limit forced revenue operators to make compromises in their data management 
approach, creating broad continent-level suppression that restricted prospecting effectiveness and limited 
precise audience targeting.  

Now RevOps teams can create granular policies where emails are suppressed in Germany, phone numbers 
suppressed in Spain, and full data access maintained in Italy—maximizing available data for account research, 
territory planning, and campaign execution while maintaining strict compliance. The expanded capacity 
appears automatically in your Data Passport Controls settings, empowering revenue operators at 
multinational organizations to optimize their complete GTM data strategy. 

Use Case Tags: Data Management, Account Insights, Audience Development, Territory Design and 
Segmentation, Prospecting​
Primary Personas: Revenue Operations, Information Technology/Security 

 

Microsoft Intune Support for Chorus Mobile App 

IT teams can now deploy the Chorus Mobile App to enterprise devices without violating mobile device 
management policies, ensuring sales teams get mobile access while maintaining corporate security 
compliance. Previously, organizations using Microsoft Intune (enterprise mobile device management 
platform) couldn't deploy Chorus Mobile App to managed devices, forcing teams to choose between mobile 
productivity and IT policy adherence. Deploy through your existing Intune admin center using the same 
process as any other enterprise app - no special configuration required. 

Use Case Tags: Administration & Setup​
Primary Personas: Information Technology/Security, Revenue Operations 
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Applications 

Copilot 

 

Top Contacts 2.0 with AI-Powered Contact Recommendations 

Get the most relevant contacts at any company with machine learning that recommends 7-10 prospects 
based on your past engagements and activity. See key recommended contacts at a given company based on 
previous people you viewed, copied, exported, emailed, or called before. Access these recommendations 
alongside enhanced filtering (Job Title, Department, Management Level, Location) directly in company 
profiles through your Copilot subscription.  

For example, if you typically email VPs of Sales at 200-500 employee SaaS companies, it prioritizes similar 
contacts first so you do less work to find the right kind of contacts for them. If no recommendations are 
available, you still have access to buying groups and key filters to find and target the right contacts. 
Previously, users spent 4 hours a week manually researching contacts and switching between tools because 
the original Top Contacts lacked essential filters and intelligent prioritization. 

Use Case Tags: Prospecting, Account Insights, Data Management​
Primary Personas: Account Executives, Sales Development Representatives, Account Managers 

 

Keyboard Shortcut for Chrome Extension 

Use Cmd+J (Mac) or Ctrl+J (Windows) to open and close your ReachOut extension—a convenience 
improvement for power users who access the extension frequently. Instead of clicking the extension icon 
15-20 times during a prospecting session, you can stay on your keyboard and hit the shortcut. Enable it by 
updating to the latest ReachOut Chrome Extension and setting your shortcut preferences in 
chrome://extensions/shortcuts. 

Use Case Tags: Prospecting, Data Management​
Primary Personas: Account Executives, Sales Development Representatives 

 

Enhanced Copilot Chat with Advanced AI Capabilities 

Walk into prospect calls with complete context by asking Copilot Chat for real-time company news, recent 
email engagement patterns, and relationship insights in one conversation. The upgraded Claude Sonnet 4 AI 
delivers improved reasoning capabilities and better context retention, while new real-time web search 
provides current company updates and industry trends beyond ZoomInfo's database. Extended thinking 
capabilities allow deeper analysis of complex queries, and automated monthly engagement summaries from 
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your email communications eliminate hours of manual review. Find these enhancements in your existing 
Copilot Chat on the Account AI tab. 

Use Case Tags: Account Insights, Prospecting, Deal Management 
Primary Personas: Account Managers, Account Executives 

 

Upcoming Meeting Plays 

Get automatic alerts for meetings in the next 24 hours with attendee names, roles, and AI-generated meeting 
summaries so you can reference past interactions and navigate stakeholder dynamics more effectively. See 
who's joining each call and review relevant account history to ask better discovery questions and connect 
with the right decision makers. Available automatically in Copilot Enterprise with calendar integration. 

Use Case Tags: Account Insights, Prospecting​
Primary Personas: Account Executives, Account Managers 
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Marketing 

 

Campaign Forecasting International & Video Expansion 

Get realistic reach estimates for your video campaigns in 10 international markets—see that your UK 
campaign will generate 15,000 video plays before spending $8,000, or compare audience sizes across 
Canada and Australia in a single forecast. Previously, you could only forecast US display campaigns, leaving 
international expansion and video budgets as guesswork. Available now in your campaign builder under 
"Forecasting" with no setup required. 

Use Case Tags: Ad Campaign Execution & ABM, Audience Development, Account Prioritization​
Primary Personas: Marketing Operations, Demand Generation 

 

Zip Code + Radius Filter Update in ZI Marketing 

To improve system reliability, ZI Marketing audience searches combining zip code and radius filters are limited 
to 50 zip codes (down from 500). Zip code searches without radius filters will  still support 500 zip codes. 
Your Account Manager will reach out if any of your current audiences are affected. 

Use Case Tags: Audience Development, Ad Campaign Execution & ABM​
Primary Personas: Marketing Operations, Demand Generation Managers, Digital Marketing Managers 
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GTM Studio 

 

Data Agent Extended Prompt Capacity 

Include complete email templates, detailed competitive analysis frameworks, and comprehensive research 
instructions when asking Data Agent to generate personalized outreach sequences or strategic account 
intelligence. Revenue operations teams can now execute complex account segmentation analysis and GTM 
strategy development with 100,000-character prompts instead of being limited to 1,000 characters, which 
prevented including full context like sample emails, analysis criteria, or multi-step research workflows. Access 
this expanded capacity in both the Data Agent modal and side panel when enriching workbooks. 

Use Case Tags: Account Insights, Prospecting, Territory Design and Segmentation 

Primary Personas: Revenue Operations 

 

Saved Workbook Views 

Save workbook filters and sorting conditions as custom Views to instantly recreate your analysis 
configurations and share them with your team. Instead of repeatedly applying the same filters and sorting 
every time you analyze accounts, you can now create Views like "High-Priority Prospects" or "Territory 
Analysis" that any team member can access with one click. Create Views from the Views dropdown in any 
workbook—note that Views reset to default when you log back in, so you'll need to reselect your preferred 
View each session. 

Use Case Tags: Data Management, Account Prioritization, Territory Design and Segmentation, Prospecting 
Primary Personas: Revenue Operations, Sales Leadership 
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